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Contacting BMC Software

You can access the BMC Software website at http://www.bmc.com. From this website, you can obtain information 
about the company, its products, corporate offices, special events, and career opportunities.

United States and Canada

Address BMC SOFTWARE INC
2101 CITYWEST BLVD
HOUSTON TX 77042-2827 
USA

Telephone 713 918 8800  or
800 841 2031

Fax 713 918 8000

Outside United States and Canada

Telephone (01) 713 918 8800 Fax (01) 713 918 8000

Copyright 2006 BMC Software, Inc., as an unpublished work. All rights reserved.

BMC Software, the BMC Software logos, and all other BMC Software product or service names are registered trademarks 
or trademarks of BMC Software, Inc.

IBM is a registered trademark of International Business Machines Corporation.

Oracle is a registered trademark, and the Oracle product names are registered trademarks or trademarks of Oracle 
Corporation.

All other trademarks belong to their respective companies.

BMC Software considers information included in this documentation to be proprietary and confidential. Your use of this 
information is subject to the terms and conditions of the applicable End User License Agreement for the product and the 
proprietary and restricted rights notices included in this documentation.

Restricted rights legend

U.S. Government Restricted Rights to Computer Software. UNPUBLISHED -- RIGHTS RESERVED UNDER THE 
COPYRIGHT LAWS OF THE UNITED STATES. Use, duplication, or disclosure of any data and computer software by the 
U.S. Government is subject to restrictions, as applicable, set forth in FAR Section 52.227-14, DFARS 252.227-7013, DFARS 
252.227-7014, DFARS 252.227-7015, and DFARS 252.227-7025, as amended from time to time. Contractor/Manufacturer is 
BMC SOFTWARE INC, 2101 CITYWEST BLVD, HOUSTON TX 77042-2827, USA. Any contract notices should be sent to 
this address. 

http://www.bmc.com
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Customer support

You can obtain technical support by using the BMC Software Customer Support website or by contacting Customer 
Support by telephone or e-mail. To expedite your inquiry, see “Before contacting BMC.”

Support website

You can obtain technical support from BMC 24 hours a day, 7 days a week at http://www.bmc.com/support_home. 
From this website, you can

■ read overviews about support services and programs that BMC offers
■ find the most current information about BMC products
■ search a database for issues similar to yours and possible solutions
■ order or download product documentation
■ report an issue or ask a question
■ subscribe to receive proactive e-mail alerts when new product notices are released
■ find worldwide BMC support center locations and contact information, including e-mail addresses, fax numbers, and 

telephone numbers 

Support by telephone or e-mail

In the United States and Canada, if you need technical support and do not have access to the web, call 800 537 1813 or 
send an e-mail message to support@bmc.com. Outside the United States and Canada, contact your local support center for 
assistance. 

Before contacting BMC

Have the following information available so that Customer Support can begin working on your issue immediately:

■ product information

— product name
— product version (release number)
— license number and password (trial or permanent)

■ operating system and environment information

— machine type
— operating system type, version, and service pack or other maintenance level such as PUT or PTF
— system hardware configuration
— serial numbers
— related software (database, application, and communication) including type, version, and service pack or 

maintenance level

■ sequence of events leading to the issue

■ commands and options that you used

■ messages received (and the time and date that you received them)

— product error messages
— messages from the operating system, such as file system full
— messages from related software 

http://www.bmc.com/support_home
mailto:support@bmc.com
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About this book
This book contains detailed information about working with 
CONTROL-D/WebAccess Server and is intended for CONTROL-D/ WebAccess 
Server users.

CONTROL-D/WebAccess Server is also referred to in this document as WebAccess 
Server.

How this book is organized
This book is organized as follows. In addition, an index is located at the end.

NOTE  
This book assumes that you are familiar with your host operating system. 

Chapter/appendix number and title Description

Chapter 1, “Overview” provides an overview of WebAccess Server

Chapter 2, “Getting started” describes basic logon procedures

Chapter 3, “Finding the reports you need” describes the methods used to find reports

Chapter 4, “Viewing reports” describes the methods used to view reports

Chapter 5, “Managing folders and reports” describes report management features

Chapter 6, “Managing logical views” describes the tools used to manage logical views

Appendix A, “Display types” describes titles or column headings displayed in 
a Report List window

Appendix B, “Icons and navigation 
buttons”

describes the icons and navigational buttons 
displayed in WebAccess Server

Appendix B, “Error messages” defines messages used in WebAccess Server
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Related documentation

Related documentation
BMC Software products offer several types of documentation:

■ online books
■ online Help
■ release notes

Online books

Like most BMC Software documentation, this book is available in online formats. 
Visit the BMC Software Customer Support page at 
http://www.bmc.com/support_home to view online books and notices (such as 
release notes and technical bulletins). Some product shipments also include the 
online books on a documentation CD.

Online help

You can access Help for a product through the product’s Help menu. The online Help 
provides information about the product’s graphical user interface (GUI) and provides 
instructions for completing tasks.

Release notes

Printed release notes accompany each BMC Software product. Release notes provide 
up-to-date information such as

■ updates to the installation instructions
■ last-minute product information

The latest versions of the release notes are also available on the Web at 
http://www.bmc.com/support.

NOTE  
Online books are formatted as Portable Document Format (PDF) or HTML files. To view, 
print, or copy PDF books, use the free Acrobat Reader from Adobe Systems. If your product 
installation does not install the reader, you can obtain the reader at http://www.adobe.com.

http://www.bmc.com/support


About this book 15

Conventions

Conventions
The following conventions are used in this book:

■ This book includes special elements called examples, notes, and tips.

■ All syntax, operating system terms, and literal examples are 
presented in this typeface.

■ In instructions, boldface type highlights information that you enter. File names, 
directories, and Web addresses also appear in boldface type.

■ The symbol » denotes one-step instructions.

■ In syntax, path names, or system messages, italic text represents a variable, as 
shown in the following examples:

The table table_name is not available.

system/instance/file_name

EXAMPLE  
An example clarifies a concept discussed in text.

NOTE  
Notes provide additional information about the current subject.

TIP  
A tip provides useful information that may improve product performance or make 
procedures easier to follow.
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Conventions
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C h a p t e r 1
1  Overview

CONTROL-D/WebAccess Server accesses reports via the Internet. It uses your Web 
browser to let you view reports using sophisticated viewers, filters, and indexing 
capabilities. 

Some of the advantages are

■ universal availability
You can access reports efficiently and securely from anywhere in the world.

■ user friendly
If you are familiar with standard Web browsers, you can start using WebAccess 
Server immediately.

■ multi-repository support
You can access reports on the following repositories without the need to install 
client software:

WebAccess Server formats text reports as HTML documents. Plug-ins and helper 
applications are employed to access the data.

WebAccess Server supports the following Web browsers:

■ Microsoft Internet Explorer versions 5.5 with service pack 2 and 6.0 with service 
pack 1. If you create Logical Views, ensure that either the Microsoft Java Virtual 
Machine is enabled or that the Sun Java Virtual Machine is installed.

■ Mozilla Firefox version 1.5

NOTE  
References to Internet include Intranet.
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Using CONTROL-D/WebAccess Server
The processes and the tools used to view reports are summarized below:

1. Log in using the Login window.

In this window, you can also

■ change the repository password
■ select a GUI language

2. Select a report using the Report List window.

In this window, you can also

■ filter the report list
■ sort the report list
■ print multiple reports
■ find text in multiple reports
■ transform several text reports into a single unified PDF report

3. View the report using the Report Viewing window.

In this window, you can also

■ search for text
■ use indexes to view specific report parts
■ customize the report display
■ transform report viewing format
■ add notes

These processes and tools, as well as the WebAccess Server management tools and 
utilities are described in the following chapters.

NOTE  
Hebrew and Hebrew Enabled display languages are supported by Microsoft Internet Explorer 
version 5.5, with Service Pack 2, and version 6.0, with Service Pack 1.
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Where to go from here

To do this See This

Log in “Logging on” on page 21

Select a report “Selecting reports for viewing” on page 28

View a report “Understanding the Report Viewing window” on 
page 43
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C h a p t e r 2
2  Getting started

You log on to CONTROL-D/WebAccess Server using the Login window. From the 
Login window, you can also perform the following tasks:

Logging on
To access repository reports, you must log on with an authorized user name and 
password.

To access CONTROL-D/WebAccess Server

1 Open your Web browser.

2 In the Address field of Microsoft Internet Explorer or in the Location field of Mozilla 
Firefox, enter the URL of your WebAccess Server (supplied by your system 
administrator).

You can also access WebAccess Server via a URL supplied as a link on a document, 
Web page, or email message.

Upon entering the URL, one of the following login windows is displayed:

■ Selected Hosts Login window
■ Single Sign-On Login window (see page 23)

To do this See this

log on to a repository “Logging on” on page 21

change your repository password “Changing your repository password” on page 25

choose a user interface language “Choosing the user interface language” on page 26
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The type of login window displayed is determined by the WebAccess Server 
administrator.

Selected Hosts Login window

The Selected Hosts Login window lets you access reports from a single repository. To 
access reports from a different repository, you must disconnect from the current 
repository and log on to another one.

Table 1 describes the Selected Hosts Login window fields.

To log on to a repository

1 Enter your User Name and Password and select a Host.

The host specified represents a repository. Your user name and password must be 
registered at the repository.

If your report list is very large or you already know which types of reports you 
want to display, you can select the Filter check box. For more information, see 
“Filtering the report list” on page 30.

2 Click Login.

Table 1 Selected Hosts Login window fields

Field Description

User Name user name that is registered at the repository

Password password that is registered with the user name at the repository

Host repository name

Filter check box opens the Filter window before displaying the Report List window. 
This can considerably reduce access time, especially when dealing 
with a long report list. For more information, see “Filtering the report 
list” on page 30.

Login button initiates the procedure for logging on to the repository

Change Password 
hyperlink

lets you change the repository password

For more information, see “Changing your repository password” on 
page 25.

Change Language 
hyperlink

lets you change the GUI language

For more information, see “Choosing the user interface language” on 
page 26.

Help button displays online Help
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After logging on to a repository, one of the following report folders is displayed in 
the Report List window:

■ the contents of the root (START) folder
■ the contents of the last-visited folder (if cookies are enabled on your Web 

browser)

If you selected the Filter check box in Step 1, the Filter window is displayed instead 
of one of the report folders. 

Where to go from here

Single Sign-On Login window

The Single Sign-On Login window lets you log in to one or more predefined 
repositories with a single logon. In addition, you can preset the list of repositories that 
is displayed in the Report List window.

Table 2 describes the Single Sign-On Login window fields.

To log on to repositories

1 Enter your User Name and Password.

2 Click Login.

To Do This See This

Find the reports you need “Navigating the Report List window” on page 28

Table 2 Single Sign-On Login window fields

Field Description

User Name user name that is registered at the desired repositories

Password password that is registered with the above user name at the desired 
repositories

Login button initiates the procedure for logging in to the repository

Change Password 
hyperlink

lets you change the repository password

For more information, see “Changing your repository password” on 
page 25.

Change Language 
hyperlink

lets you change the GUI language. For more information, see 
“Choosing the user interface language” on page 26.

Help button displays online Help
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The first time you log on, the Select Preset Repositories window is displayed. Use 
this window to preset the repositories that you want to access in the Report List 
window. In subsequent logins, the Report List window is displayed with the list of 
your selected repositories.

3 Select the repositories to which you want to access by performing the following:

A Select a repository from the Available Repositories list, and click Select (or 
double-click the repository). You can select multiple repositories by using the 
Ctrl and Shift keys.

You can arrange the order in which the repositories are listed in the Report List 
window by selecting a repository in the Selected Repositories list and clicking 
Move Up or Move Down. You can select multiple repositories by using the Ctrl 
and Shift keys.

B To save your selections, click Save. If cookies are enabled on your Web browser, 
your settings are saved for subsequent sessions.

The Report List window opens displaying the list of preset repositories in the 
left pane.

One of the following report folders is displayed in the Report List window:

■ the contents of the root (START) folder
■ the contents of the last-visited folder (if cookies are enabled on your Web 

browser)

NOTE  
To change the list of selected repositories after your first sign-on, click Filter Preset 
Repositories.
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Figure 1 shows a typical Report List window after logging on through the Single 
Sign-On Login window.

Figure 1 Report List window—Single Sign-On Login

Where to go from here

Changing your repository password 
The CONTROL-D/WebAccess Server administrator can let you change your 
repository password from the Selected Hosts Login window or the Single Sign-On 
Login window. If this option is enabled, the Change Password hyperlink is displayed 
in the Login window.

To change your password

1 In the Login window, click the Change Password hyperlink. The Change Password 
window is displayed.

2 Enter your User Name and Old Password.

3 Enter your New Password and re-enter it in the Confirm Password field.

4 Select a Host.

To Go to

Find the reports you need “Navigating the Report List window” on page 28

NOTE  
When changing your password from the Single Sign-On Login window, the Host and Filter 
options are not displayed. 

These 
repositories 
have been 
selected.



Choosing the user interface language

26 CONTROL-D/WebAccess Server User Guide

5 Click Login to complete the password change and log on (or click Back to Login to 
return to the Login window without changing your password).

Choosing the user interface language
You can change the display language by selecting any of the following languages 
from the Login window:

■ Chinese
■ English
■ French
■ German
■ Hebrew
■ Hebrew-Enabled (displays Hebrew reports with an English user interface)
■ Italian
■ Portuguese (Brazilian)
■ Spanish

To choose a user interface language

In the Login window, click the Change Language hyperlink and select a language.

The user interface is displayed in the selected language. If cookies are enabled, this 
language becomes the default language for this computer until another language is 
selected. (Otherwise, English is the default language).

To see your current default language

Click the Change Language hyperlink.

The default language is displayed with a check mark in the drop-down menu.

NOTE  
When changing your password from the Single Sign-On Login window, the change affects all 
selected repositories. If no repositories are selected, the Select Preset Repositories window is 
displayed after you click Login.

NOTE  
The list of available user interface languages and the initial language displayed are 
determined by the WebAccess Server administrator.
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C h a p t e r 3
3  Finding the reports you need

This chapter discusses the Report List window and describes how to quickly and 
efficiently locate the reports that interest you.

The report icon displayed on the report line in the Report List window indicates the 
report type. 

For more information on report icons, see Appendix B, “Icons and navigation 
buttons.”

You can display a report in the following formats:

■ the format indicated by the report icon (the native, or default report type)
■ a transformed format that you select

To display a report in the default format

Click the report name.

For information on how to display a report in a transformed format, see Chapter 4, 
“Viewing reports.”

To do this See this

view report lists “Navigating the Report List window” on page 28

locate reports in folders “Selecting reports for viewing” on page 28

list only those reports that are relevant 
to you

“Filtering the report list” on page 30

list the reports in a logical order “Sorting the report list” on page 40
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Navigating the Report List window
The Report List window displays reports and folders. 

The Report List window contains the following areas:

Selecting reports for viewing
The Report List window displays the names of reports stored in the “logged-in” 
location. WebAccess Server contains the tools to let you browse report folders quickly 
and find the reports that interest you.

To display folders 

Click the expand icon .

Available subfolders are displayed in a tree view. If, after clicking the expand symbol, 
the symbol is no longer displayed, there are no subfolders.

Figure 2 shows how folders are displayed when the expand icon is clicked. 

NOTE  
The WebAccess Server windows you see may vary from those described in this document, 
depending on the configuration options chosen at your site.

Name Description

Title Bar contains the window description, navigation buttons, and 
status indicators (for examle, sort, filter)

Report List Toolbar displays report list tools

Report List 
Window

displays report names and display types
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Figure 2 Displaying available folders

To view the contents of a folder

Click the folder icon  or folder name.

The list of reports in the folder is displayed in the Report List window.

Figure 3 shows how reports stored in the current folder are displayed in the Report 
List.

Figure 3 Displaying stored reports

To return to parent folders

Click on the parent folder in the folder area.

The contents of the parent folder are displayed in the Report List window.

NOTE  
To close a folder, click .

Path to the current 
folder



Filtering the report list

30 CONTROL-D/WebAccess Server User Guide

Filtering the report list
You can control which reports are displayed in the report list by filtering the list. For 
example, you may want to list only certain types of reports (such as AFP reports) or 
reports belonging to a certain recipient. 

Filtering the report list is especially useful when the report list is very long and you 
only need to access a certain subset of the reports at the logged in location, or when 
you want to retrieve reports from a certain subfolder (for example, for a certain 
recipient in the recipient tree).

To apply filter criteria, use the Filter window.

To open the Filter window

Perform one of the following:

■ From the Report List window, click Filter.

■ From the Report Viewing window, point to Back to the Report List and choose New 
filter.

■ From the Login window, select the Filter option and click Login.

To filter the report list

1 Open the Filter window.

The Report Parameters tab of the Filter window is displayed.

You can define the filter criteria using the following Filter window tabs:

The fields in each tab are described under “Filter options and buttons” on page 32.

2 Select the filter criteria by performing one of the following:

■ Select a predefined filter from the Filter Name list box.

Tab Filters By

Report Parameters report characteristics (such as report name and recipient)

Date & Time date and time characteristics (such as decollation date and 
age of report)

Report Type report type (such as AFP and PDF)

Index index names and values
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■ Enter filter criteria.

3 Click Apply.

Only reports that meet filter criteria are listed in the Report List window. If no report 
meets filter criteria, a message is displayed indicating that the report list is empty.

A filter icon  is displayed in the Report List window title bar to indicate that the 
report list is filtered. 

To save a filter definition

1 In the Filter window, click Save. The Save Predefined Filter window is displayed.

2 Type a filter name.

3 To set this filter as the default filter, select Default.

The default filter is displayed whenever the filter window is opened.

4 Click Save.

The saved filter is selected in the Filter Name box in the filter window.

To delete a predefined filter definition

1 In the Filter window, select a predefined filter.

2 Click Delete.

A confirmation message is displayed.

3 Click Yes.

The following table describes other filter-related actions.

NOTE  
The tabs and fields displayed depend on the settings set by the administrator in 
CONTROL-D/Desktop.

If cookies are not enabled on your Web browser, some options are not displayed in the 
Filter window.
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Filter options and buttons

The following table describes the options and buttons available on the Filter window.

Filter tabs

Report parameters tab

The Report Parameters tab lets you filter for report characteristics (such as report 
name and recipient).

To do this Perform these steps

clear filter criteria 1. In the Filter window, click Reset.

2. Click Apply.

view the unfiltered Report 
List window

Click Cancel Filter.

return to the filtered Report 
List window

Click Back to the Report List.

cancel the filter in the Report 
Viewing window

Point to Back to the Report List and choose Unfiltered.

Table 3 Filter Options and Buttons

Option or button Description

Filter Name lets you select a predefined filter

Include Filtered Subfolders 
From

applies filter criteria to any of the following folders:

■ Current folder only 

■ Current folder and subfolders

■ All folders

Matching reports are collected from all subfolders and listed 
together in the filtered folder. In the “All folders” option, 
reports are listed in the START folder. 

Apply to All Folders applies the filter criteria to every folder that is accessed

Save opens the Save Predefined Filters window

Delete deletes the current predefined filter

Apply applies filter criteria to the report list

Reset clears all filter fields
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Table 4 describes the filter criteria available in the Report Parameters tab. For more 
information on general filter options, see “Filter options and buttons” on page 32.

For information on how to filter the report list using index values, see “Index tab” on 
page 38.

For more information about using wildcards, see “Filtering with wildcard characters” 
on page 34.

For more information about using multiple values, see “Filtering with multiple 
values” on page 35.

Table 4 Filter criteria in the Report Parameters tab (part 1 of 2) (part 1 of 2)

Item
Wild
cards

Multiple 
values Description

Report Name Yes Yes matches the specified report name

Job Name Yes Yes matches reports created by the specified job

Remark Yes Yes matches reports having specified remarks or completion 
codes

■ For MF repository reports, if MSGCLASS output is 
decollated, the Remark field holds the return and 
termination codes, and any other value entered during 
decollation. 

■ For DS repository reports, this can be the value of the 
Remark field for reports created using the Create New 
Document window.

Category Yes Yes matches reports with this category name

Category is an informative field that specifies the 
decollation that produced this report.

Index Name No Yes matches reports with this index name. This value is 
case-sensitive

The index name can be entered here or from the Index tab. 

Note: The number of Index Names must be the same as the 
number of Index Values. The Index Values must be in the 
same order as their corresponding Index Names.
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 Filtering with wildcard characters

The asterisk (*) wildcard character can be used in the Report Parameters tab to 
implement searches (in supported filter criteria fields as indicated in the above table) 
using pattern matching. The asterisk wildcard can represent a single character or a 
group of characters that match a filter criteria.

Wildcards can be used in the filter criteria fields as indicated in Table 4. Wildcards 
can be used anywhere in the field. 

Index Value No Yes matches reports with this index value. This value is 
case-sensitive.

The index value refers directly to one of the values of the 
name specified in Index Name. Reports opened from the 
filtered list contain only the pages with matching indexes. 
The index value can be entered here or from the Index tab.

Note: The number of Index Names must be the same as the 
number of Index Values. The Index Values must be in the 
same order as their corresponding Index Names.

Recipient Yes Yes matches reports with this recipient name

Containing 
Text

No No matches DS repository reports that contain the specified text

Version No No matches DS repository reports with this version number

Version numbers are created by the check in and check out 
process.

Generation No No matches DS repository reports with this generation number

A report can have several generations stored in the 
repository. For example, a salary report with the same name 
is generated and added to the repository each month. By 
default, the last report generated is displayed in the Report 
List window.

Report Status No No matches reports with the following status

■ Active
non-migrated reports 

■ History
long term archived reports

■ Migrated
reports that have been moved to an alternative location 
from the active report folder

Table 4 Filter criteria in the Report Parameters tab (part 2 of 2) (part 2 of 2)

Item
Wild
cards

Multiple 
values Description
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Example

Assume that you have reports with the following names at the logged in location:

Departments, Daily, Revenues, Rates, Sales. 

The following table shows which reports are accessed when the specified characters 
are entered in the Report Name field of the Filter window:

Filtering with multiple values

Filtering with multiple values is available only in the Report name, Job name, Remark 
and Category fields. This feature is supported in CONTROL-D for z/OS version 
6.2.00 and later.

Multiple values must be separated by commas. 

If the parameter value (for example, report name) includes commas, the value must 
be surrounded with double quotation marks.

If the parameter value contains double quotation marks, an extra double quotation 
mark character must be added before each double quotation mark character.

Date & Time tab

The Date & Time tab lets you filter for reports that match specified date and time 
characteristics, such as decollation date or age of report.

This section describes the fields specific to the Date & Time tab. For more information 
on general filter options, see “Filter options and buttons” on page 32.

Date type

Reports matching the specified date type are listed.

Table 6 defines valid date types.

Table 5 Reports displayed based on Report Name field entries

Entry Listed reports

D* Departments, Daily

De* Departments

*s Departments, Revenues, Rates, Sales

R*es Revenues, Rates
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Date From/To

Reports with dates in the specified range are listed. The date range relates directly to 
criteria specified in the Date Type field. 

Specify a date range using the format displayed in the Date & Time tab (for 
example, mm/dd/yyyy).

Date range can also be represented as a calculation with respect to “today’s date” 
using the keyword #today or # today-n where -n represents the number of preceding 
days relative to today (for example, #today, # today-5).

You can make the range open-ended. If the Date To field is blank, all reports with 
dates later than (and including) the date specified in the Date From field are selected. 
If the Date From field is blank, all reports with dates earlier than (and including) the 
date specified in the Date To field are selected.

Period

Reports that became available within the specified number of days are listed. If 
Period is specified, the Date From and To fields are automatically filled in with the 
selected period. 

Table 7 defines available periods for dates.

Table 6 Date types

Type Description

Decollated date and time the report was decollated (processed for 
distribution by CONTROL-D)

Ordered date the report was ordered (scheduled to run)

Run start date and time of the job that created the report

EXAMPLE  
Date Type: Decollated
Date From:  #today -2  To:  #today
Reports that were decollated from the day before yesterday, yesterday, and today are listed.

EXAMPLE  
Date From:  01/01/2000 To:
The range is open-ended. Reports from 01/01/2000 and any later date are listed.
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Current date is

Displays the current system date.

Current date format is

Displays the system date format for input (for example, mm/dd/yyyy indicates that 
a 2-digit month, 2-digit day, and a 4-digit year must be used to enter dates). 

Time From/To

Reports whose times are in the specified range are listed. The time range also relates 
to the criteria specified in the Date Type field. This field is not relevant when using 
the Ordered date type. Time ranges are set using the hh/mm and 24-hour clock 
formats.

You can make the range open-ended. If the Time To field is blank, all reports with 
times later than (and including) the date specified in the Time From field are selected.

If the Time From field is blank, all reports with times before (and including) the time 
specified in the To field are selected.

Table 7 Available periods 

Period Description

Last Day reports that became available today

Last 5 Days reports that became available within the last 5 days

Last 10 Days reports that became available within the last 10 days

Last 20 Days reports that became available within the last 20 days

NOTE  
When retrieving reports using the Ordered date type filter option, the Time From and To filter 
option is disabled. Any values entered in the Time From and To fields are not used as filter 
criteria.

EXAMPLE  
Date Type: Decollated
Time From   15:00   To   08:00
Reports that were decollated between 3 p.m. to 8 a.m. the next day are listed.

EXAMPLE  
Time From  10:30   To
Reports from 10:30 a.m.



Filter tabs

38 CONTROL-D/WebAccess Server User Guide

When using the date and time filter options together, the following method is used to 
retrieve reports:

■ from the Date From date until the Date To date, between the Time From hours and 
the Time To hours.

Report Type tab

The Report Type tab lets you filter for reports that match specified report types (such 
as AFP or PDF).

This section describes the fields specific to the Report Type tab. For more information 
on general filter options, see “Filter options and buttons” on page 32.

Table 8 describes the filter criteria available in the Report Type tab.

Index tab

The Index tab lets you filter for reports in CONTROL-D or CONTROL-D for 
Distributed Systems repositories. You can search the repository for specific indexes in 
reports.

The reports listed in the filtered Report List window contain only the report pages 
that contain a corresponding index name and value.

EXAMPLE  
Date From: 01/01/2000 To: 01/31/2000
Time From: 07:00 To: 08:00
Retrieves reports that became available in January between 7am and 8am (that is, one hour 
per day).

Table 8 Filter criteria in the Report Type tab

Item Description

Text Reports text reports are listed

AFP Reports AFP reports are listed

XEROX Reports XEROX reports are listed

PDF Reports Adobe Acrobat reports are listed

Other Reports all other reports are listed
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To filter for reports that contain index values

1 In the Filter window, click the Index tab.

2 In CONTROL-D repositories, select the index from the index tree. In CONTROL-D 
for Distributed Systems, click the drop-down arrow in the Available Indexes list 
box to display a list of available indexes.

You can specify an Index value prefix or mask (including wildcard characters) in 
the list box to filter the list of index values. 

3 Select the required indexes from the available indexes.

One or more list boxes are displayed. Each list box contains the available index 
values for the selected index name.

4 Select a value for each selected index. (Click the drop-down arrow in the associated 
list box to display a list of available index values.)

5 Click Apply.

The Report List window displays only those reports that match the selected criteria.

NOTE  
In mainframe repositories, you see all index paths in the tree of index names. The paths 
that are displayed in gray cannot be selected. Available paths are displayed as blue 
clickable links.

NOTE  
The index name and value are displayed in the Index Name and Index Value fields in the 
Report Parameters tab. If more than one index is selected, the selected index names and 
values are separated by # .

If your reports contain the #  character, change the separator character as follows:

1. Open bin/htmls/translate/js_filter.js.

2. Find there following string: 

var index_delimiter = "#"; 

3. replace the #  character with a character that is not used in your report names.
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Sorting the report list
You can sort report lists by any display type, even one that is not displayed in the 
Report List window.

Use the Sort window to apply sort criteria to the Report List window.

To open the Sort window

Click Sort. The Sort Report List window is displayed.

To sort the report list

1 Open the Sort window.

2 Select a display type by which to sort from the first Sort by list box.

3 Select the corresponding Ascending or Descending option. 

4 To add more sorting criteria, select the display type in each lower lever Sort by list 
box and select the sorting order (ascending or descending).

5 Click Apply.

The Report List window is displayed with the sorting criteria applied. A sort icon 
 is displayed in the Report List window title bar. Point to the sort icon to 

display the selected “Sort by” criteria.

Table 9 describes the available fields in the Sort Report List window.

NOTE  
In CONTROL-D/Desktop, the administrator can set whether users can sort using all report 
list fields, or only those fields that are available in the report list window.

NOTE  
Your administrator may configure WebAccess Server to automatically sort your report list 
based on the last sort operation you performed.
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If sort criteria is applied to the report list when the Sort window is opened, the 
applied sort criteria is displayed in the Sort by fields.

Similarly, if default sort criteria is defined for the repository, the default sort criteria is 
displayed in the Sort by fields.

Table 9 Sort Report List window fields

Field Description

Sort by display type to sort by

You can choose up to three display types with which to sort.

Ascending or
Descending

sort order

Ascending sorts first from the lowest number, the beginning of the 
alphabet, or the earliest date in the sorted list. Descending sorts first 
from the highest number, the end of the alphabet, or the latest date in 
the sorted list. lank cells are first in the sort order.

Reset clears all sort fields

Default sets the sort fields to default values configured by the WebAccess 
Server administrator

Apply applies the selected sort criteria
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C h a p t e r 4
4  Viewing reports

Reports are displayed in the Report Viewing window.

To view a report, you can place the cursor on the report name and choose Open report 
from the menu, or click the report name.

This chapter discusses report viewing and describes how to quickly and efficiently 
view data that interests you in the most appropriate format.

When the Web browser accesses a non-text report, the appropriate application (plug-
in, helper) is invoked to view the report. Plug-ins must be installed and configured on 
the system before you can display the report.

Understanding the Report Viewing window
The Report Viewing window can be configured to display in one of the following 
modes:

■ Single
The Report Viewing window replaces the Report List window in the same Web 
browser window.

To See this

navigate report pages “Navigating report pages” on page 45

find desired text “Searching for text strings” on page 46

view specific report areas “Using indexes to view reports” on page 51

customize the way that report 
data is displayed

“Customizing the report display” on page 53

change the format in which a 
report is displayed

“Viewing reports in transformed formats” on page 60
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■ Dual
The Report Viewing window is displayed in a separate Web browser window. 
Each new report opened replaces the current open report.

■ Multiple
The Report Viewing window is displayed in a separate Web browser window and 
a new browser window is opened for each report that is opened.

Figure 4 shows the Report Viewing window.

Figure 4 Report Viewing window

The Report Viewing window contains the following areas:

■ Title Bar
displays the window description, navigation buttons, and status indicators (for 
example, find, index)

■ Find Toolbar
lets you search for text

■ Report View Toolbar
displays report viewing tools

■ Report Viewing Area
displays the report data

Report Viewing Area

Title Bar Find Toolbar Report View Toolbar
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The Report Viewing toolbars are always displayed for text reports. When Excel, 
Word, or PDF reports are opened in the Report Viewing window, their application 
toolbars are displayed. By default, the WebAccess Server Report Viewing toolbars are 
not displayed when Excel or Word reports are opened. For other reports types, by 
default, the Report Viewing toolbars are displayed in addition to the external 
application toolbars.

The administrator can configure CONTROL-D/WebAccess Server so that the Report 
Viewing window toolbars are not displayed together with the external application 
toolbars.

For more information on icons and navigation buttons, see Appendix B, “Icons and 
navigation buttons.”

Navigating report pages

Report viewing is accomplished by transferring report pages from the repository to 
your Web browser. A set of several pages (default: 5) is sent to your browser each 
time a single transfer request is made.

Within any set of report pages, you can scroll through pages using common keyboard 
(for example, page up, page down) and browser (for example, scroll bar) features.

To access report page sets, use the following buttons (located on the title bar):

To go directly to a specific page

Type the page number in the Load Page text box  and click Go. This option is 
available with text reports and reports transformed to HTML (in page mode only).

NOTE  
If you are using Firefox, Excel and Word files always open with their application toolbars 
even if the system administrator set them to open with the WebAccess toolbar.

Button Description

accesses the next set of report pages

accesses the previous set of report pages

accesses the first set of report pages

accesses the last set of report pages
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Searching for text strings
The Find option lets you locate all occurrences of a specified string. Advanced Find 
lets you specify a search direction as well as additional search criteria.

In some repositories, you may be able to search a limited number of pages at a time. 
In this case, a message is displayed asking if you want to continue.

Using Find

The Find option can function in two different ways depending on how the 
WebAccess Server administrator configures this function.

The table below describes the two types of find functions and their differences:

The default, Itemized Find, is used for the examples presented in this section.

To search for a text string

1 Type a text string in the Find text box  and click Go.

If the search string is found, the first report page containing the match is displayed 
in the Report Viewing window.

Itemized Find Find

The first match is highlighted in blue. All 
other matches are highlighted in yellow.

All matching text is highlighted in yellow.

Clicking  moves the blue highlighting to 
the next matching text in the current set of 
pages.

Clicking  displays matching text on the 
next set of pages. Additional matches in the 
current set of pages can be viewed using the 
scroll bars.

Matches in the next set of pages can be 
viewed by clicking .

Matches in the next set of pages can be 
viewed by clicking .
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Figure 5 illustrates how each instance of the found string is highlighted. The 
currently selected instance is highlighted in blue; subsequent instances are 
highlighted in yellow.

Figure 5 Using the Find Text box

2 To go to the next instance, click . To go to the previous instance, click .

If the next instance is located in a subsequent page set, that page set is brought into 
the browser. You can also use the navigation buttons to access the next or previous 
set of pages. For more information, see “Navigating report pages” on page 45.

3 To clear previously specified Find criteria, click .

The  icon is displayed in the upper right corner of the Report Viewing window 
when a search is active. You can point to the icon to display the search criteria.

Using Advanced Find

Advanced Find lets you specify search direction, case-sensitivity, whole or partial 
words, and page viewing options.

To use Advanced Find

1 In the Find navigation panel, click the Advanced hyperlink. The Advanced Find 
window is displayed.

2 Type a text string. 



Using Advanced Find

48 CONTROL-D/WebAccess Server User Guide

3 Modify the search by selecting direction and search options.

4 Click Find. 

If the search string is found, the first report page containing the match is displayed 
in the Report Viewing window.

Each found instance of the search string is highlighted in the Report Viewing 
window. The currently selected instance is highlighted in blue; subsequent 
instances are highlighted in yellow.

5 To view the next instance, click . To view the previous instance, click .

If the next instance is located in a subsequent page set, that page set is brought into 
the browser. You can also use the navigation buttons to access the next or previous 
set of pages.

6 To clear previously specified Find criteria and highlighting, click .

The  icon is displayed in the upper right corner of the Report Viewing window 
when a search is active. You can point to the icon to display the search criteria.

Advanced Find window

Table 10 describes the fields in the Advanced Find window.

Table 10 Advanced Find window fields  (part 1 of 2)

Field Description

Find the search string

Direction search direction

■ Top down
searches downward from the top (beginning) of the report

■ Down
searches downward from the top of the current set of pages

■ Up
searches upward from the bottom of the current set of pages

■ Bottom up
searches upward from the bottom (end) of the report
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Using Multiple Find

The Multiple Find option lets you search multiple reports for a specified string.

To use Multiple Find

1 In the Reports List window, select at least one report and click the Find in Reports 
icon, located in the upper right corner of the Reports List window. 

2 In the Find in Reports window, type a text string. 

3 Modify the search by selecting search options.

4 Click Find. 

If the search string is found, the results are displayed in the lower pane of the Find 
in Reports window, using a hierarchy consisting of reports, pages, and lines. Each 
found instance of the search string is highlighted in yellow. In the results pane, 
each report name has a link that you can use to open the report to see the searched 
term. Similarly, each result page has a link that you can use to open the report 
starting with the specified page. Whichever link you use to open the report, the 
searched term appears highlighted in the report as if a regular search for that term 
was performed.

5 You can use the navigation buttons to search the next or previous set of pages.

To view the next set of pages, click  or . 

To view the previous set of pages, click  or .

See Table 11 for more details about the fields in the Find in Reports window.

Options additional search criteria

■ Case sensitive
case matching is performed

■ Whole word
only complete word matches are found

■ Show only matched pages
only the pages in which the search string was found are displayed.

Find button initiates the search

Table 10 Advanced Find window fields  (part 2 of 2)

Field Description
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Table 11 Find in Reports window fields  (part 1 of 2)

Item Description

Text box the search string

Check boxes additional search criteria

■ Case sensitive
- case matching is performed

■ Whole word
- only complete word matches are found

■ Show only matched pages
- only the pages in which the search string was found are displayed 
when you view a report from the Find in Reports window

■ Search Backwards
- searches upward from the end of the last selected report

■ One Page per report
- only one page is retrieved for each report in the results page
This is useful if you are only interested in finding the reports in which 
the searched string appears, but you are not interested in each of the 
occurrences of the string in the reports.

■ Collapse results
- results are first displayed in a collapsed state
This is useful if you expect the searched string to appear in many 
reports.
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Using indexes to view reports
Indexes let you access specific data without viewing the entire report. This decreases 
access time, especially when dealing with very large reports.

Reports can contain indexes at both the page level and the record level:

■ Report indexes
display report pages that match index criteria

Next/Previous 
buttons

specifies direction and scope of the search

Search previous <number of pages> pages, while skipping the 
current report

- searches upward, starting from the end of the report preceding 
the first report in the current results

Search previous <number of pages> pages

- searches upward, starting from the page preceding the first 
page in the current results

Search next <number of pages> pages

- searches downward, starting from the page following the last 
page in the current results

Search next <number of pages> pages, while skipping the 
current report

- searches downward, starting from the report following the last 
report in the current results

Note: <number of pages> is the number of result pages that are displayed 
for every find request. The default is 5 pages, but your administrator can 
change the number of pages.

Tip: If the current report contains many occurrences of the searched 
string, but you are not interested in examining all of them, you can skip 
over the current report to search the other reports using 

the Next or Previous buttons with the skipping option. 

Find button initiates a new search

Table 11 Find in Reports window fields  (part 2 of 2)

Item Description
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■ Record level indexes
display report pages that contain data that matches index criteria. The matching 
report lines (records) are highlighted

Index filtering applies index criteria to the currently displayed (or selected) report.

Report indexes

A report can have multiple indexes. The retrieved report contains only the pages 
relevant to the selected indexes.

For example, if the report contains index matches on pages 1, 7, and 15-18, the 
following page sets are returned (assuming 5 pages per set):

Use the Select Index window to view reports that match index criteria.

To view a report using indexes

1 In the Report List window, point to the report name you want to view and choose 
Open Index.

2 Select an index name.

3 You can select index values using the following methods:

■ Click the drop-down arrow and select a value.

■ Type a value prefix in the list box. For example, typing G retrieves index values 
beginning with the prefix and all letters after that (G to Z).

4 To add more filter criteria (when available), repeat step 2 and step 3.

Page set Pages included

1 1, 7, 15, 16, 17

2 18

NOTE  
Report indexes are only available when an index icon (  or  ) is displayed for the 
report in the Report List window.
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Subindexes can be displayed by clicking the parent index.

5 Click View.

When indexes are active, the  icon is displayed in the upper right corner of the 
Report Viewing window. You can point to the icon to display the index criteria.

You can use the Select Index window to print indexed report pages. For more 
information, see “Printing reports” on page 81.

Customizing the report display
Logical views customize the way that report data is displayed. Consider a report that 
contains many columns of information. When the report data is displayed, the report 
lines exceed the width of the display area. Although much of the information may not 
be relevant, you must scroll horizontally to reach the columns that are relevant, 
making viewing cumbersome and tedious.

To alleviate this situation, logical views can be created that hide unnecessary 
information and enable the relevant columns to be displayed.

You can customize the display of report data by using the following types of logical 
views:

■ static logical views
A logical view changes the appearance of a text report by applying an editing 
template to regions of the report layout. For example, a logical view can 

— add headers or graphics
— modify font attributes such as type, color, or size
— hide unnecessary information
— rearrange columns
— freeze report areas
— define attributes of report areas for transformation to spreadsheet format

■ dynamic logical views
A dynamic logical view lets you change the appearance of a text report by 
including, excluding, or coloring report lines and strings.

NOTE  
When more than one index is selected, the index search is performed using the 
mathematical AND operator. For example, Account Number = 213467234 AND Customer 
Name = Greg Brady.
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You can use the Logical View Editor to create and edit logical views. For more 
information, see Chapter 6, “Managing logical views.”

Using static logical views

You can open a report with a logical view from the Report List window, or apply a 
logical view directly from the Report Viewing window.

To open a report with a logical view from the Report List window

Point to Report Name => Logical View and choose the logical view you want to use 
with the report.

The Report Viewing window displays the report with the selected logical view.

The  icon is displayed in the upper right corner of the Report Viewing window. 
You can point to the icon to display the name of the logical view that is currently 
applied.

To apply a logical view to a report already displayed in the Report Viewing 
window

Point to Tools => Logical View => Logical View and choose a logical view name.

The report is displayed with the selected logical view.

Figure 6 illustrates a report displayed with a logical view in the Report Viewing 
window. The selected logical view highlights report lines where the interest amount 
is greater than 7.0 or the deposit amount is greater than 10,000.

NOTE  
Some logical views may require a significant amount of time to process.
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Figure 6 Logical view applied

To clear a logical view from a report displayed in the Report Viewing window

Point to Tools => Logical View and choose Clear.

The report is displayed without a logical view.

Using export definitions to view reports in spreadsheet 
format

Export definitions are a form of static logical view that enhance the formatting of text 
report data for transformation to Excel format. For example, export definitions can 
define the width of columns and the label, number, date, and time style of cells. When 
you open a report with an export definition, the report is automatically transformed 
to Excel format and displayed in the Report Viewing window.

Export definitions can include both standard logical view instructions (for example, 
hide or move text, apply color) and Excel transformation instructions (for example, 
define column width and format). 

Apply export definitions to reports in the same way as other logical views.

You can apply the export definition’s standard logical view instructions without 
implementing the Excel transformation instructions by choosing the Native Format 
option. In this case, the report is displayed in text format in the Report Viewing 
window.

To apply an export definition in text format

From the logical view menu (in the Report List window or the Report Viewing 
window), point to export definition name and choose Native Format.
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Figure 7 Applying an export definition in Native Format

The administrator configures whether export definitions are displayed differently 
than other logical views. If so, the Excel icon  is displayed in the logical view menu 
indicating that a logical view is an export definition.

Freezing headers, footers, and edges

A logical view can freeze the headers, footers, and edges of report pages. Freezing an 
area in a report prevents it from disappearing from the window when scrolling.

When you open a report with a logical view, frozen headers and footers always 
belong to the first page of the current set of pages on the Web browser. For example, 
consider a set consisting of five pages. When scrolling through pages 1 to 5, the page 
1 headers and footers are displayed. For pages 6-10, the page 6 headers and footers 
are displayed. Right and left edges display the correct text for each individual page.

Figure 8 illustrates the frozen header from the first page displayed at the top of the 
Report Viewing window.
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Figure 8 Frozen header—example

Using dynamic logical views

Dynamic logical views let you actively apply a mask to predefined report areas while 
viewing a report. For example, you can use a dynamic mask to display only those 
employees belonging to a particular department number, or to exclude bank 
customers whose accounts are below a specified credit level.

The creator of the logical view determines which columns of a report can be used as 
dynamic mask criteria. 

To view a report using a dynamic logical view

1 Apply a dynamic logical view to a report. For more information, see “Using static 
logical views” on page 54.

The report is displayed in the Report Viewing window.

2 Point to Tools and choose Dynamic Logical View.

The Dynamic Logical View window is displayed.

NOTE  
Some versions of Firefox may not scroll frozen areas as expected.

NOTE  
The Dynamic Logical View button is displayed only when a dynamic logical view has been 
applied to the report.
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3 Enter the criteria for the mask and click Apply.

The Report Viewing window displays the report with the selected mask applied.

Figure 9 illustrates a dynamic mask applied to a report in the Report Viewing 
window.

Figure 9 Dynamic mask applied to a report

To clear the entered mask criteria

Click Reset.

Dynamic Mask window

Table 12 describes the Dynamic Logical View window fields and buttons.

NOTE  
The AND operator and OR operator function according to standard mathematical rules.

Color is used to 
highlight all 
deposit amounts 
above 10,000.



Using dynamic logical views

Chapter 4 Viewing reports 59

Table 12 Mask criteria (part 1 of 2)

Item Description

Column Name name of the column to which to apply masking criteria

Operator logical test operators

■ =
equal

■ >
greater than

■ <
less than

■ >=
greater than or equal to

■ <=
less than or equal to

■ <>
not equal to

■ Between
value between high and low values

Low Value low number or string value

High Value high number or string value

Condition logical “AND” or “OR” conditions.

If either condition is selected, an additional line is displayed 
that lets you specify further masking criteria. To delete the 
additional line, delete the extra condition.

Masking Line masking operations to be performed on lines that match 
criteria

■ Include
only matching values are displayed

■ Exclude
matching values are not displayed

■ Paint Line
Rows that contain a matching value are highlighted

■ Paint String
values that match are highlighted

Foreground Color and 
Background Color palettes

palettes that let you choose a foreground and background 
color for matching lines and strings (displayed when Paint 
Line or Paint String are selected)
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Viewing reports in transformed formats
You can change the display format of AFP, PCL, PDF, PS, XRX, and TXT reports. The 
report itself remains unchanged.

You can use transformers to display a report in the following ways:

■ in a transformed format
You can transform reports to alternate formats.

■ in the report’s native format
You can view a report in its original format instead of viewing it in its default 
transformer format.

Viewing reports in transformed format

You can view reports in another format by applying a transformer to the report.

You can transform reports to Hyper Text Markup Language (HTML), Portable 
Document Format (PDF), text (TXT), and Microsoft Excel (XLS) formats.

Reset clears the fields in the window

Apply applies the masking criteria

NOTE  
The ‘=’ (equal) logical operator behaves differently for columns defined as numbers and those 
defined as strings. For number columns, the operator means equal. For columns defined as 
strings, the operator means “contains” or “matches.” 
For example, for number columns ‘35’ does not equal ‘1351’. For string columns, ‘35’ does 
equal ‘1351’ because the string ‘1351’ contains the string ‘35’.

NOTE  
Tag notes and logical views are not supported for transformed reports.

Table 12 Mask criteria (part 2 of 2)

Item Description
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To view a report in transformed format

Point to Report name => View As and choose the desired transformed viewing format.

The report is displayed in the selected format.

Figure 10 shows an AFP report displayed in PDF format.

Figure 10 AFP Report Displayed in PDF Format

Viewing text reports in Excel format

You can transform text reports to Excel spreadsheet format in the following formats:

■ as-is
The report data is displayed in one column of an Excel worksheet.

■ enhanced
The report display is enhanced with formatting (for example, column width, 
labels) by applying an export definition logical view. For more information on 
export definitions, see “Using export definitions to view reports in spreadsheet 
format” on page 55.

Each report page is displayed as a separate worksheet in the displayed Excel 
workbook.

To view a text report in Excel format as-is

Point to Report name => View As and choose the Excel transformer.
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Figure 11 Transforming a text report as-is

The report is displayed in the Report Viewing window.

Figure 12 Text report transformed as-is

To transform a text report with an export definition

Point to Report name => View As => Excel transformer and choose the desired export 
definition name.

Figure 13 Transforming a text report with an export definition
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The report is displayed with the export definition in the Report Viewing window. 
Note the effect of applying the logical view.

Figure 14 Text report transformed with an export definition

Viewing reports in native format

Your WebAccess Server administrator can set a default transformer for each report 
type. If this is the case, clicking the report name displays the report in the default 
transformer format.

You can view a report in its native—untransformed—format, by selecting Native 
Format from the View As menu.

To view a text report in its native format

Point to Report name => View As and choose Native Format.

NOTE  
The administrator determines whether export definitions are treated differently than other 
logical views. If so, the pop-up menu displays only export definitions (marked by an icon). If 
not, the pop-up menu displays all logical views for the report.

NOTE  
In some cases, converted files are not displayed in the Report Viewing window. A message 
box is displayed that lets you open the file in your default spreadsheet application or save it to 
disk.
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Figure 15 Transforming a text report to its native format

The report is displayed in native—text—format.

Figure 16 Text report displayed in native format
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C h a p t e r 5
5  Managing folders and reports

You can manage folders and reports using the CONTROL-D/WebAccess Server 
features listed in the following table:

Managing folders
In Distributed Systems repositories, you can perform the following folder operations:

■ create
■ rename
■ copy
■ move
■ delete

Folder operations are performed using the folder toolbar located in the top right of 
the Report List window.

To See This

move, copy, or delete a report “Report operations” on page 67

use report notes “Using report notes” on page 72

email a report “Emailing reports” on page 79

print a report “Printing reports” on page 81

save a report “Saving reports” on page 85

view report properties “Viewing report properties” on page 86

NOTE  
If CONTROL-D/WebAccess Server is connected to a CONTROL-D mainframe repository, the 
folders are actually mainframe recipients. This means that no folder manipulations can be 
performed when connected to a mainframe repository.
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Figure 17 Folder toolbar

To create or rename a folder

1 Select a folder to expand or rename, and click the respective icon on the folder 
toolbar.

The Create Folder or Rename Folder window is displayed.

2 Type the name of the folder and click Apply.

To copy a folder

1 Select a folder to copy, and click the copy icon  on the folder toolbar.

The Copy Folder window is displayed.

2 To copy the folder to an existing folder, select (or type) the new location.

3 To copy the folder to a new folder, click New, and create the new folder as 
described in “To create or rename a folder” on page 66.

The new folder name is entered in the To field of the Copy Report window.

4 Click Apply.

To move a folder

1 Select a folder to move, and click the move icon  on the folder toolbar.

The Move Folder window is displayed.

2 To move the folder to an existing folder, select (or type) the new location.

3 To move the folder to a new folder, click New, and create the new folder as 
described in “To create or rename a folder” on page 66.

NOTE  
To create a subfolder, you must first create the parent folder, and then create the subfolder. 
You cannot use a backslash or forward slash to create both folders at once.

Move CreateDelete

RenamCopy
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The new folder name is entered in the To field of the Move Folder window.

4 Click Apply.

To delete a folder

1 Select the folder to delete, and click the delete icon  on the folder toolbar.

The Delete Folder window is displayed.

2 Click Apply to delete the selected folder.

Report operations
You can perform the following report operations:

■ create (DS repository only)
■ rename (DS repository only)
■ move
■ copy
■ delete

You can create new reports in the repository by uploading files stored on your PC.

To create a report

1 In the Tree Navigation area (or the Folder Path navigation area) of the Report List 
window, select the folder where you want to create the report.

Reports cannot be created in the root (START) folder.

2 Click New Document .

The Create New Document window is displayed.

3 In the Source File field, type the full path of the file (for example, c:\reports\freight 
invoices.txt), or click Browse to locate the file.

4 Enter the document name and file type (extension).

WARNING  
Deleting a folder deletes its subfolders and reports.
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5 Type a remark and expiration date if desired.

Enter the expiration date in the displayed format.

6 To disable the report from being checked out, select the Final check box.

For more information on report versions, click “Managing report versions” on 
page 70.

7 To enable text search filtering, select the Enable Text Search check box.

8 To enable global index filtering, enter the values in the Index Name and Value text 
boxes.

For more information on filtering, click “Filtering the report list” on page 30.

9 Click Create.

The report is added to the repository and listed in the Report List window.

Renaming, copying, moving, and deleting reports

The rename, copy, move, and delete report operations are performed by using the 
report menu displayed when you point to report name => Report in the Report List 
window.

Figure 18 Report Menu
 



Renaming, copying, moving, and deleting reports

Chapter 5 Managing folders and reports 69

To rename a report

1 Point to report name => Report and choose Rename.

The Rename Report window is displayed.

2 Type the new name and click Apply.

To copy or move a report to an existing folder

1 Point to report name => Report and choose Copy (or Move).

The Copy Report (or Move Report) window is displayed.

2 Type the new location (or select the new location from the folder tree) and click 
Apply.

To copy or move a report to a new folder

1 Point to report name => Report and choose Move (or Copy).

The Move Report (or Copy Report) window is displayed.

2 Click New.

The Create Folder window is displayed.

3 Type the new folder name and click Apply.

The new folder is entered in the To text field of the Copy Report window.

4 Click Apply.

The new folder is displayed in the Report List window (even if you cancel the 
Copy operation).

To delete a report

1 Point to report name => Report and choose Delete.

The Delete Report window is displayed.

2 To delete all versions of the selected report, select All Versions.

3 Click Apply.
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Managing report versions
DS repositories can store several versions of a report. Report version numbers are 
shown in the Version column in the Report List window. By default, the latest version 
of the report is listed in the report list. To view previous versions, click “Filtering the 
report list” on page 30.

Use the following options to manage report versions:

■ Checkout

Downloads the latest version of a report from the repository and “locks” it to 
prevents other users from checking it out. 

Some reports (for example, a monthly salary report) are marked “final” and cannot 
be checked out. “Final” reports can be 

— generated by CONTROL-D/Decollation Server
— created in WebAccess Server via the Create Document window with the “Final” 

option selected

■ Checkin

Checks an updated version of a report into the repository. A report can only be 
checked in by the user who checked it out.

■ Revert

Cancels the checkout command. Revert can only be used by the user who checked 
out the report.

■ Get

Downloads a report that is currently checked out. The currently checked out report 
can be checked out again only after it is checked back in by the original user.

To check out a report

1 Click the Checkout icon  on the report line of the Report List window.

The Version Control window is displayed.

2 Click Check out.
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A File Download dialog box may be displayed. 

3 Select Save this file to disk and click OK.

The Save As dialog box is displayed.

4 Click the drop-down arrow in the Save in list box to select a folder for the file. You 
can also change the file name.

5 Click Save.

The locked icon  is displayed in the Check-Out Status column of the Report List 
window and your user name is displayed in the Checked Out By column. The 
report can be viewed by other users, but they can only check out the report after it 
is checked back into the repository. 

To check in a report

1 In the Report List window, click the Locked icon  for the report that you have 
checked out from the repository.

The Version Control window is displayed.

2 Click Check In.

The Check In window is displayed.

3 Type the full path to the checked-out report (for example, c:\reports\freight 
invoices.txt), or click Browse to locate the report.

4 Click Check In.

The report is checked in and the Checkout icon  is displayed in the Check-Out 
Status column of the Report List window. Your user name is removed from the 
Checked Out By column. The report version number is updated.

To revert to the previous version of a report

1 In the Report List window, click the Locked icon  for a report that you checked 
out from the repository.

The Version Control window is displayed.

2 Click Revert.
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The report returns to its previous version. The Checkout icon  is displayed in 
the Checkout Status column. Your user name is removed from the Checked Out By 
column.

To download a locked report

1 Click the Locked icon  of the report that you want to download.

The Version Control window is displayed.

2 Click Get.

The File Download dialog box is displayed. 

3 Select Save this file to disk, and click OK.

The Save As dialog box is displayed.

4 Click the drop-down arrow in the Save in list box to select a folder for the file, and 
click Save.

The report is downloaded to your PC. 

Using report notes
Report notes let you annotate entire documents or document sections. The following 
types of report notes can be created and viewed:

■ general notes
attached to a report (of any type)

■ tag notes
attached to specific areas of text reports only

A report cannot have more than one general note (though several versions can be 
generated), but it can contain up to 1000 tag notes.

In the Report List window, one of the following icons is displayed (in the report 
attributes column) for a report that contains notes.

 indicates that notes are attached to the report

 indicates that notes and indexes are attached to the report
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Opening the Notes window

You can add new versions to existing notes and delete notes using the Notes window. 
The Notes window can be opened either from the Report List window or the Report 
Viewing window.

To open the Notes window

Perform one of the following:

■ From the Report List window, point to the report name and choose Notes.

■ From the Report Viewing window, perform one of the following:

— For text reports, point to Tools and choose Notes , or click on 
the text associated with the note.

— For non-text reports, click Notes.

The Notes window is displayed.

The note list area displays the notes associated with the current report. The general 
note is displayed at the top of the note list, followed by any tag notes that were 
created for the report. When the Notes window is opened from the Report List 
window or from the Tools menu in the report view, by default, the general note is 
selected and its text is displayed in the note text area. However, when the Notes 
window is opened by clicking the text associated with a tag note, this tag note is 
selected and its text is displayed in the note text area.

The note text area displays versions of the general note and the tag notes. The 
versions are sorted by date and time of creation, either in ascending or descending 
order, depending how the administrator configured WebAccess Server in 
CONTROL-D/Desktop.

Creating general notes

General notes can be created from the Report List window or the Report Viewing 
window.

TIP  
To quickly view a report area associated with a tag note, click Tag Note  next to the tag 
note name. The associated area is displayed at the top of the Report Viewing window.



Creating tag notes

74 CONTROL-D/WebAccess Server User Guide

To create a general note or add a general note version

1 Open the Notes window.

For more information, see “Opening the Notes window” on page 73.

2 Enter the text for the note or version in the text box.

3 Click Add.

The note or version is displayed in the note text area (together with your user name 
and the time and date the note or version was created). 

Creating tag notes

Tag notes can be created from the Report Viewing window for the currently 
displayed report. You can create tag notes only from the Notes mode, but you can 
view them from either Notes mode or View mode. 

When you apply a Logical View to a report, it applies to both View and Notes modes, 
so that the locations of the tag notes are adjusted according to the applied logical 
view.

To add a new tag note

1 From the Report Viewing window, click Notes Mode.

2 Select Text Tag Note using the tag note icon .

NOTE  
For mainframe repository reports, the text is limited to a maximum of 10 lines, with each 
line limited to a maximum of 56 characters.

NOTE  
Previous note versions can be viewed, but not edited.

NOTE  
Only the text commands of logical views are applied in Notes mode, while the user interface 
commands are ignored, making it is easier to add tag notes.
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3 Use the cursor to select the text where you want to attach the tag note. The New 
Tag Note dialog box automatically opens with the selected text entered as the note 
name. You can keep this text or enter a different note name.

4 Enter the text for the note or version in the Note Text box.

5 Click Add.

In View mode, the report text associated with the note is displayed underlined in 
the report. In Notes mode, the report text associated with the note is high-lighted 
in the report.

Figure 19 illustrates high-lighted tag note text in the Notes mode of the Report 
Viewing window.

Figure 19 Tag note indicators and tag icons in Notes mode

NOTE  
The note name cannot exceed 20 characters in CONTROL-D for Distributed Systems 
repositories and cannot exceed 40 characters in CONTROL-D mainframe repositories.

NOTE  
For mainframe repository reports, the text is limited to a maximum of 10 lines, with each 
line limited to a maximum of 56 characters.
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Marking reports with tag icons

A report can be marked with tag icons from the Report Viewing window for the 
currently displayed report (see Figure 19). You mark reports with tag icons only from 
the Notes mode, but you can view them from either Notes mode or View mode. 

When you apply a Logical View to a report, it applies to both View and Notes modes, 
so that the locations of the tag icons are adjusted according to the applied logical 
view.

To mark a report with a tag icon

1 From the Report Viewing window, click Notes Mode.

2 Select a tag icon by clicking one of the tag note icons .

3 Click on the location in the report where you want to mark with the tag icon. The 
location in the report is immediately marked with icon. Click on additional 
locations and select other tag icons as necessary to mark the report according to 
your requirements.

4 Save the report with the tag icon markings by clicking Save . All tag 
icons on the current set of pages are saved.

Viewing notes information

General notes and tag notes are viewed in the Notes window. For more information, 
see “Opening the Notes window” on page 73.

If you place the cursor over the icon in report it displays the following information 
about the icon:

■ Created on - the date when the icon was created
■ Created by - the user wo created the icon
■ Description - A brief description (only in Notes mode)

NOTE  
Only the text commands of logical views are applied in Notes mode, while the user interface 
commands are ignored, making it is easier to add tag icons.
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To view notes

1 Open the Notes window.

2 To view a specific tag note, click its hyperlink (the name given to the tag note) in 
the note list area.

3 To view the general note, click the General Note hyperlink.

The name of the currently displayed note is highlighted in the note list area.

Printing notes and tag icons

You can specify that notes and tag icons are included when printing a text report. The 
notes printing and tag icon printing options are available on the Options tab in the 
Print dialog box. You can also specify how the notes are printed, by choosing one of 
the following options on the Options tab, as described in “Print” on page 81 and 
Table 13: 

■ Print at end of report
■ Print at end of page
■ Print only notes

Changing icons

You can change an icon only if you are working in Notes mode. Tag notes cannot be 
deleted from the report list or from the report view. Tag notes can be deleted only 
from the Notes window. The Notes window can be accessed from the report list and 
report view.

To change an icon

1 Left click an icon in the report.

2 In the window that opens, click Change and in the new window select the 
replacement icon.

TIP  
In the Report Viewing window, click the underlined text (in View mode) or the highlighted 
text (in Notes mode) to display its associated tag note in the Notes window.

You can create new versions of the general and tag notes during note viewing.
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Deleting tag notes and icons

Tag notes can be deleted from the Report List window or the Report Viewing 
window. Tag icons can only be deleted in Notes mode from the Report Viewing 
window.

To delete a single tag note

1 Open the Notes window.

For more information, see “Opening the Notes window” on page 73.

2 Select the note that you want to delete.

3 Click Delete.

4 Confirm that you want to delete the selected note.

To delete all tag notes in a report

1 Open the Notes window.

For more information, see “Opening the Notes window” on page 73.

2 Click Delete All.

3 Confirm that you want to delete all the notes in the report.

To delete a tag icon from a report

1 From the Report Viewing window, click Notes Mode.

2 In the report, place the cursor over the tag icon that you want to delete. When the 
cursor changes to a hand, click on the tag icon. a pop up window appears with 
option buttons to delete or change the icon. Click on the delete option. The tag icon 
is immediately deleted from the report.

3 Save the report with the deleted tag icon removed from the markings by clicking 
Save . 

To delete all tag icons from a report

1 From the Report Viewing window, click Notes Mode.

2 Click Delete . All tag icons are immediately deleted from the current 
set of pages and these report pages are saved without any tag icons. 
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Emailing reports
You can enable others to access report data via an email message. A report can be 
emailed in its original format or after transformation. It can also include indexes and 
a logical view.

Use one of the following methods to send the report:

■ URL
A URL to the report is sent in an email message. The report can be viewed in a Web 
browser after logging in through a WebAccess Server login window.

■ Attachment
The report is sent as an email attachment. HTML reports cannot be sent as an 
attachment.

■ Email text
The report data is sent as a text email message. This option is available for text 
reports only and supports logical view commands that manipulate text (for 
example, move or hide), but not coloring or other formatting commands (for 
example, fonts or overlays).

Use the Email window to send a report in an email message.

To open the Email window

Perform one of the following:

■ From the Report List window, click Email  on the report name line or choose 
Email from the menu.

■ From the Report Viewing window, perform one of the following:

— For text reports, point to Report and choose Send by Mail.
— For non-text reports, click Send by Mail.

The Email window is displayed.

NOTE  
Tag notes and icons can be deleted only by their owner (the user who created the tag note or 
icons) if the administrator set the appropriate parameters in Desktop.
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To send a report by email

1 Open the Email window.

2 Select a send option.

When sending non-text reports, the Email text option is not available.

3 Select a logical view and/or viewing format to apply to the report.

Logical views are supported for text reports only.

If there are no logical views or transformers available for the report, the respective 
drop-down box is not displayed.

When sending reports as email text, transformations are not supported.

4 Select the pages to send.

5 To send only indexed areas of a report, perform the following:

A Select the Index tab.

The Index tab is only displayed if the report contains indexes.

B Select the index criteria.

6 Click Send.

A new message window is opened in your default email program. Use the 
appropriate command to send the email from your email program.

NOTE  
Page range may not be available for all report types.

NOTE  
During the local email operation a progress bar is displayed that indicates the progress status. 
In the case of page-mode reports, the Cancel button in the progress dialog box can be used to 
cancel the sending operation while it is in progress. 

NOTE  
The first time you send a report via email, your Web browser may prompt you to download 
or install the Local Operations ActiveX.
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Printing reports
WebAccess Server offers the following printing options:

Print

Print lets you print report data on a local printer from the Report List window or 
Report Viewing window.

To print advanced format reports (for example, PDF), an appropriate application 
must be installed on your PC.

To print indexed and transformed report pages from binary reports (such as AFP or 
PDF), see “To print indexed report pages with a logical view or in transformed 
format” on page 83.

The print method varies depending on whether the selected report is in a text or non-
text format.

To print a text report on a local printer

1 Open the Print dialog box by performing one of the following:

■ From the Report List window, place the mouse cursor over the report name you 
wish to print and choose Print from the menu or click the print icon.

■ From the Report Viewing window, point to Report => Print and choose Print.

Print Method Where Printed What’s Printed

print local printer report data with logical 
views, notes, and icons

host print CONTROL-D repository site report data with 
CONTROL-D printing 
rulers

prepare to print local printer report data with logical 
views

NOTE  
The first time you print a report locally, your Web browser may prompt you to download or 
install the Local Operations ActiveX.
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2 In the Report parameters section on the General tab, you may select a transformation 
and a logical view option.

The report parameter options may vary depending on the selected report.

3 Choose the Options tab and select the appropriate options as described in Table 13 
on page 82. 

4 Click Print.

To print a report in a different format

From the Report List window, place the cursor on the name of the report and choose 
Print as => transformer_format.

If a print dialog box is displayed, set the settings, and click Print.

Table 13 Options tab in the Print dialog box

Options group item options

Include in Report Header and Footer N/A

Notes ■ At the end of the report
■ At the end of each page
■ Print only notes

Tag Icons N/A

Fit to Page N/A ■ Shrink oversize pages to paper size
■ Expand undersized pages to paper size
■ Auto-rotate pages (rotates pages 90 degrees to fit page)

NOTE  
For some HTML reports, a second Print window is displayed. Select the desired print 
options and click Print.

NOTE  
When locally printing, an external application print dialog box opens before the print 
operation begins, enabling the user to select printing settings. In CONTROL-D/Desktop, 
the administrator can prevent the external application print dialog box from opening for 
WORD, EXCEL, or PDF reports. If the print dialog box does not open, the local print 
operation uses the printing settings previously set for the particular external application.

NOTE  
During the local print operation a progress dialog box is displayed. For page mode reports 
this dialog box contains a progress bar that indicates the progress status. The Cancel button 
in the progress dialog box can be used to cancel the printing while it is in progress.
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To print indexed report pages with a logical view or in transformed format

1 Open the Select Index window and select the index criteria.

For more information on selecting indexes, see “Using indexes to view reports” on 
page 51.

2 Select the desired logical view and transformer.

3 Click Print.

4 Select print criteria and click Print.

To print multiple reports

1 In the Report List window, select more than one report by selecting the check 
boxes (or by pressing Ctrl or Shift) and click Multiple Print .

The Multiple Report Print window is displayed.

2 Click Print.

3 In the Print window, enter print criteria and click OK.

All report pages are printed, using the default logical view and transformer.

Host Print

Host Print lets you print report data with CONTROL-D printing rulers at the 
CONTROL-D repository site.

To print associated reports, the host computer must support the report format that 
you want to print.

Use the Host Print window to specify the print parameters required at the host site.

To print a report at the repository site

1 Place the cursor on the name of the report and choose Host Print from the menu or 
click Host Print.

2 Enter the print range and number of copies.
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3 To defer the report printing according to predefined print missions, perform the 
following:

A Select Deferred print time.

The Print Missions fields are displayed.

B Enter the print mission names. Print missions contain specific report printing 
parameters (for example, printer name, print date and time) and are defined by 
the system administrator.

4 To print indexed pages, select the Index tab and select index criteria.

The Index tab is only displayed if the report contains indexes and the Host Print 
window was opened either from the Report List window or from the Report 
Viewing window (without selecting indexes). For more information on selecting 
index criteria, see “Using indexes to view reports” on page 51.

5 Click Print.

Prepare to Print

Prepare to Print lets you print report data on a local printer using the Web browser’s 
print function. You can select logical views and indexes. Selected report pages are 
copied into a single browser window from where they can be printed using your 
browser’s Print option.

Print specifications are specified in the Prepare to Print window.

NOTE  
Your system administrator will inform you if you need to fill in the Print Setting fields, 
such as Destination, Ruler, Writer Name, and Formdef.

NOTE  
Prepare to Print is supported for text reports in page mode and HTML reports in page mode.

Page breaks are not displayed when using the Prepare to Print option.
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To print a report on the local printer using Prepare to Print

1 In the Report List window, place the cursor on the name of the report and choose 
Prepare to Print from the menu or click Prepare to Print.

2 Enter the page range.

3 From the Logical View drop-down box, select a logical view.

4 To print indexed pages, select the Index tab and select index criteria.

The Index tab is only displayed if the report contains indexes and the Prepare to 
Print window was opened either from the Report List window or from the Report 
Viewing window (without selecting indexes). For more information on selecting 
index criteria, see “Using indexes to view reports” on page 51.

5 Click Print.

The report is displayed in a new browser window.

6 From your browser’s File menu, choose Print.

7 In the Print dialog box, set the printing options and click OK.

Saving reports
The Save option lets you save a report on your local computer.

Use the Save Report dialog box to save reports locally.

To save a report

1 In the Report List window, place the cursor on the name of the report and choose 
Save from the menu, or click the Save icon in the report list.

2 Select the folder where you want to save the file.

3 Select the report pages to save.

NOTE  
If you opened the Prepare to Print window from the Report Viewing window, the logical 
view name shown is the one with which the report is currently being displayed.
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4 Type the report name.

5 Select a transformation format and a logical view, as desired.

6 Click OK to save the report.

Viewing report properties
Report properties are identical to display types in the Report List window, except that 
they are displayed in the Report Properties window. Your administrator can choose 
to display supplemental report information in the Report List window or in the 
Report Properties window.

To view report properties

Click Report Properties  in the Report List window, or place the cursor on the 
report name and select Properties.

The Report Properties window is displayed.

The Report Properties window displays the report properties for a selected report. 
Each row displays a specific report attribute.

The CONTROL-D/WebAccess Server administrator determines which report 
properties are listed in the Report Properties window.

Updating report properties

The values displayed for report properties can be updated from the Report List 
window or the Report Properties window. When a field for a particular report is 
updated, the new value permanently replaces the previous value in the repository.

NOTE  
During the local save operation a progress bar is displayed that indicates the progress status. 
In the case of page-mode reports, the Cancel button in the progress dialog box can be used to 
cancel the saving operation while it is in progress. 

NOTE  
The first time you save a report, your Web browser may prompt you to download or install 
the Local Operations ActiveX.
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The CONTROL-D/WebAccess Server administrator determines which fields of a 
report can be updated.

To update report fields

1 In the Report List window, click the hyperlink in the field you want to update.

The Update Field window is displayed.

2 Enter the new value of the field.

3 Click Update.

NOTE  
The text box name displays the field (or property) in which you clicked the hyperlink. 
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C h a p t e r 6
6  Managing logical views

CONTROL-D/WebAccess Server enhances report viewing by allowing you to create 
and define logical views for reports. This means that you can alter the appearance of 
the report before or during viewing. For example, you can

■ hide unwanted report areas
■ define and freeze headers, footers and edges so they do not scroll out of sight when 

you scroll the report
■ display or highlight lines that match specified criteria
■ move fields to a different location
■ color text to highlight certain fields or values
■ add graphic overlays to report views

Logical views are created in the Logical View Editor window. This chapter describes 
how to define logical views. Once you have defined a logical view, you can save it for 
future use with a report. You can define many logical views for the same report.

The WebAccess Server administrator may disable access to the Logical View Editor. 
In this case, the logical view Create button may not be displayed. If the Logical View 
Editor is enabled at your site, contact your system administrator to install Java Plug-
in 1.4.2.04 or 1.5.08 on your workstation before using the editor. If SSL (HTTPS) is 
used at your site, Java Plug-in 1.4.2.04 or 1.5.08 must be installed.

NOTE  
Logical views do not alter the original report.

When working with SSL (that is, HTTPS) and Sun Java VM (when Microsoft JVM is not 
available), use Java Plug-in version 1.4.2.04 or 1.5.08.

Do not use Java Plug-in version 1.4.2.01 as it prevents Java applets from working and thus 
WebAccess Server does not function as expected. To determine the Java Plug-in version, 
double click the Java Plug-in icon in the Control Panel and select the About tab. To install a 
new version, consult the WebAccess Server Administrator.
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Basics of logical views

To display the Logical View Editor window

1 In the Report List window, point to report name => Logical View.

The Logical View menu is displayed.

Figure 20 Logical View menu

2 To create a new logical view, select Create.

3 To edit an existing logical view, point to the name of the logical view and select 
Edit. 

The Logical View Editor Loading window is displayed.

You must leave the Logical View Editor Loading window open during your entire 
editing session—otherwise your instructions and changes are lost. You can, 
however, minimize the display by clicking on the minimize button.

The Java Plug-in Security Warning window is displayed.

4 The Java Plug-in Security Warning window lets you create (install) a Logical View 
Editor session. If this window is displayed, select one of the following options:

■ Grant this session
This option lets you edit logical views in the current Web browser session only.

NOTE  
When CONTROL-D/WebAccess Server is connected to a mainframe repository, the folders 
are actually the mainframe recipients. This means that no folder manipulations are available 
when CONTROL-D/WebAccess Server is connected to a mainframe repository.
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■ Grant always
This option sets up your computer to edit logical views in this and all future 
sessions. The dialog box is not displayed the next time you request an editing 
session.

If you select Deny, the Logical View Editor does not function as expected.

The Logical View Editor window is displayed.

Figure 21 Logical View Editor window

The Logical View Editor window contains the following sections:

Section Description

1 Menu Bar
All the commands of the Logical View Editor are accessible using drop down 
menus in the menu bar.

2 Toolbars (Top and Side)
The toolbars are located above and to the left of the selection bars. They contain 
shortcut buttons for the actions that you can perform using the Edit drop-down 
menu.

3 Selection Bars (Horizontal and Vertical)

Located above and to the left of the report view, these bars indicate column 
and line numbers. They are used for selecting lines and columns.

1

5

3 (Vertical)

2 (Top)

2 (Side)

3 (Horizontal)

4
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Logical View Editor window toolbar buttons

The following section describes the toolbar buttons in the side and top toolbars.

Buttons in the side toolbar

The buttons displayed in the side toolbar are described in the following table.

4 Main Body—Report View

This area displays one page of the current logical view of the report. If no 
logical view instructions are applied, the report page is displayed in its original 
format.

5 Instruction List area
The logical view instructions that you performed are listed sequentially in the 
Instruction List area. 

At the top of the instruction list, with a sequence number of 0, is an 
“instruction” line that says Logical View - Off. Clicking this line hides all the 
instructions you have entered so that you can view the report as it appears in 
its original format.

Table 14 Logical View Editor window—side toolbar buttons (part 1 of 2)

Button Function Description

Hide Hides the selected areas of the report. Described in “Hiding an 
area of the report” on page 104.

Text Adds specified text. Described in “Adding text” on page 121.

Fill Down Copies text from rows within a selected area to blank rows 
directly under the text. Described in “Filling down text in 
existing columns” on page 117.

Fill Text Fills the selected area with the specified text. Described in 
“Adding filled rows and columns (filling text)” on page 119.

Unique Removes subsequent occurrences of repeated text. Described in 
“Hiding repetitive text (displaying unique text)” on page 116.

Label Adds a label to a selected field. This can be used later for 
identifying text for operations. Described in “Applying 
dynamic definition labels” on page 123.

Freeze Keeps the selected text in place when you scroll or shift the 
display. Especially useful for headers, footers and certain 
critical fields. Described in “Freezing margins” on page 105.

Section Description
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Buttons in the top toolbar

The buttons displayed in the horizontal toolbar are described in the following table.

Mask Includes or excludes report lines based on specified masks 
(show/hide criteria). Described in “Masking areas (including 
and excluding lines)” on page 111.

Overlay Inserts a predefined graphic overlay (usually as a background) 
into your report. Described in “Applying overlays” on page 124.

Re-edit Lets you re-edit an existing logical view instruction. Described 
in “Manipulating instructions” on page 98.

Blank 
Columns

Inserts blank columns. Described in “Adding blank lines and 
columns” on page 102.

Blank Lines Inserts blank lines. Described in “Adding blank lines and 
columns” on page 102.

Table 15 Logical View Editor window—top toolbar buttons (part 1 of 2)

Button Function Description

Save Lets you save a logical view. Described in “Saving a logical 
view” on page 100.

Export 
Definition

Lets you define export definitions for exporting report content 
to Microsoft Excel format. Described in “Exporting a report to 
an Excel file” on page 128.

Go To Page Goes to the specified report page in the Logical View Editor 
window.

First Page Displays the first report page.

Previous Page Displays the previous report page.

Next Page Displays the next report page.

Last Page Displays the last report page.

Undo / Redo Undoes the previous edit (keystroke/action). The Redo arrow 
cancels the most immediate Undo action.

Table 14 Logical View Editor window—side toolbar buttons (part 2 of 2)

Button Function Description
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Defining data preferences

Data preferences can vary from site to site, and from report to report. For example, a 
negative number in a report might be indicated by one of the following preferences:

■ enclosing the number in parentheses
■ placing a minus sign to the left of the number
■ placing a minus sign to the right of the number

You can define logical view instructions that depend on conditional criteria being 
satisfied. For example, you may decide to color red any value less than 50. For the 
Logical View editor to determine whether a value satisfies conditional criteria, certain 
data preferences need to be identified. 

For example, the Logical View Editor needs to determine whether “(500)” is negative, 
in which case it would be less than 50.

Delete Deletes the selected instruction.

Note: Do not confuse this with the keyboard Delete key.

Font Opens the Font dialog box to let you change the font of the text 
in a selected area. Described in “Applying font changes” on 
page 114.

Color Opens the Color dialog box which lets you apply color to text or 
background in a selected area. Described in “Coloring report 
areas” on page 107.

Select 
Overlays

Toggles between Overlay mode and Text mode for editing 
purposes. Described in “Applying overlays” on page 124.

Instruction 
List

Toggles between displaying and hiding the Instruction List in 
the Logical View Editor window.

Find Opens the Find dialog box to let you search for a specified 
string. Described in “To find a text string” on page 96.

About Displays information about the Logical View editor.

Table 15 Logical View Editor window—top toolbar buttons (part 2 of 2)

Button Function Description
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To define data preferences

1 Choose Tools => Preferences.

The Preferences dialog box is displayed.

The Preferences dialog box lets you specify number formatting, search options, 
and the application of control characters. Defaults are displayed.

2 Fill out the Number Format preferences as follows:

A If there is a space between the sign and the number, check the Spaces between 
sign and number box.

B Check the appropriate box to indicate how negative values are indicated in the 
report:

— Enclosed in parentheses 

— Left justified minus sign 

— Right justified minus sign 

— When you check a box, the Preview area displays an example of the 
convention in use. You can check multiple boxes to allow multiple display 
formats.

3 In the User-Defined sign area, specify symbols that may be used with numeric 
values, as follows:

A In the Left justified and Right justified fields, identify the symbol used to indicate 
a negative number. Default: minus sign.

B In the Decimal separator field, identify the symbol used to delimit a decimal. 
Default: period (decimal point)

C In the Thousands separator field, identify the symbol used to delimit the 
thousands placeholders. Default: comma.

4 In the Search Options area, check the Match case box to match only strings with the 
same case.

5 In the Control Characters area, select the types of report control characters to be 
applied. 
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6 Click OK.

Navigating the report

To navigate report pages, use the following buttons (located on the top toolbar):

To go to a specific page

1 Choose Edit => Go To Page.

The Goto dialog box is displayed.

2 Specify the required page in the Goto page no field and click OK.

The specified report page is displayed.

To find a text string

1 Choose Edit => Find.

The Find dialog box is displayed.

2 Fill in the Find dialog box as follows:

A Specify the search string in the Find what field.

B If the search string is a full word, select Match whole word only.

NOTE  
The application of control characters can cause multiple changes to the report display. 
Once you apply (or clear the application of) control characters, BMC software recommends 
that you do not change this setting, otherwise instructions in this logical view may not 
work as expected.

Button Description

Displays the first report page.

Displays the previous report page.

Displays the next report page.

Displays the last report page.
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C If the case of the word must match the case of the search string, select Match case.

D In the Direction area, choose either Up or Down as the search direction.

3 Click Find Next each time you want to perform the search with the defined criteria.

Selecting and deselecting report areas

Selecting an area spanning several columns and lines requires no special technique. 
However, if you are selecting a full line range or a full column range, the following 
methods should be used:

To select this area Do this

Entire columns 1. Place the cursor on the horizontal selection bar, so that it 
changes to an arrow. 

2. Hold the left mouse button down and drag the cursor to 
the left or right.

3. Release the mouse button when you reach the endpoint 
of the selection.

Entire rows 1. Place the cursor on the vertical selection bar, so that it 
changes to an arrow.

2. Hold the left mouse button down and drag the cursor up 
or down.

3. Release the mouse button when you have reached the 
endpoint of the selection.

From a particular point to the 
top or bottom of a page

While keeping the Shift key pressed:

1. Click the point where you want to start selecting, and 
move the cursor either up or down to the beginning or 
end of the page.

2. You can move the cursor right or left to widen the 
selection area.
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To perform multiple selections

Keep the Ctrl key pressed while performing each selection. If selection requires that 
another key be pressed (for example, Alt) then both keys should be pressed.

The specified operation is applied to all selections.

To clear current selections

Press the Esc key for each selection to be cleared.

Selections are cleared successively, beginning with the most current and working 
backwards.

To clear all selections

Choose Edit => Clear All Selections in the menu bar.

Manipulating instructions

As you define instructions, they are inserted into the instruction list sequentially. You 
can, however manipulate the instructions in the list as follows:

■ insert an instruction between other instructions
■ delete unwanted instructions from the list
■ show the implementation of instructions up to any point in the list
■ re-edit an existing instruction

From a particular point to the 
right or left side of a page

While keeping the Alt key pressed:

1. Click the point where you want to start the selection, and 
move the cursor either right or left.

2. You can move the cursor up or down to increase the 
number of rows.

The entire page Do one of the following:

■ Place the cursor at the meeting point of the selection bars, 
so that it changes to a page icon, and click it.

■ Choose Edit => Select All in the menu bar.

To select this area Do this
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To insert an instruction between instructions

Click the instruction located immediately before the intended insertion point, and 
type the new instruction.

The new instruction is inserted immediately after the instruction that you clicked.

To delete an instruction

Click the instruction to be deleted, and click Delete in the top toolbar (not the Delete 
key on the keyboard).

The instruction is deleted.

To show the implementation of instructions up to a certain point

Click the last instruction in the range that you want displayed.

The implementation of all subsequent instructions is not displayed in the report view.

If you place the cursor on the “0” level instruction (Logical View - Off), no instruction 
implementation is displayed—the report appears as it does in the original view.

To re-edit an existing instruction

1 In the Instruction List area, perform one of the following:

■ Click the instruction and then click Re-edit .
■ Double-click the instruction.

The area specified in the instruction is selected. 

2 To change the selected area, perform either of the following:

■ Change (drag) the borders of the selection area.
■ Add new selections while pressing the Ctrl key.

3 To change the instructions, perform either of the following:

■ Modify the parameters of the original instruction. (For example, use the Color 
dialog box to change a coloring instruction.)

This changes the original instruction.

■ Select a different instruction. (For example, select a Font instruction in place of a 
Color instruction.)
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This adds a new instruction after the current selection.

The instruction list reflects the requested changes.

You can manage logical views using the following operations:

■ Saving a logical view
■ Renaming a logical view
■ Deleting a logical view

Saving a logical view

From the Logical View Editor window, you can save a logical view by clicking Save 
or selecting the Save or Save As option from the File menu.

To save changes to an existing logical view

Click Save.

The logical view changes are saved.

To save a new logical view

1 Click Save. 

The Save As dialog box is displayed.

2 In the Logical view name field, specify a unique name for the logical view.

3 To make a logical view available to a group of reports, specify the mask and 
wildcard for this group in the Report Mask field. For example, if Currency* is 
specified in the Report Mask field, the logical view is available for reports called 
Currency-Dollars, Currency-Euros, and so on.

4 Click OK.

The logical view is saved with the new name.

To save an existing logical view with a new name

1 Choose File => Save As.

The Save As dialog box is displayed. It contains the current name of the logical 
view in the Logical View Name field.
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2 Specify a new name for the logical view in the Logical View Name field, change the 
Report Mask field if necessary, and click OK.

The logical view is saved with the new name.

Renaming a logical view

You can rename or delete a logical view from the Report List window.

To rename a logical view 

1 In the Report List window, point to report_name => Logical 
View => logical_view_name.

2 Click Rename.

The Rename Logical View dialog box is displayed. It displays the current name of 
the logical view in the Name field.

3 Rename the logical view and click Apply.

Deleting a logical view

You can rename a delete a logical view from the Report List window.

To delete a logical view

1 In the Report List window, point to report_name => Logical 
View => logical_view_name.

2 Click Delete.

The Delete Logical View dialog box is displayed.

3 Click Apply to delete the logical view.
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Defining logical views
Logical views can include commands for any of the following actions:

■ Adding Blank Lines and Columns
■ Moving and Copying Text
■ Hiding an Area of the Report
■ Freezing Margins
■ Coloring Report Areas
■ Masking Areas (Including and Excluding Lines)
■ Applying Font Changes
■ Hiding Repetitive Text (Displaying Unique Text)
■ Filling Down Text In Existing Columns
■ Adding Filled Rows and Columns (Filling Text)
■ Adding Text
■ Applying Dynamic Definition Labels
■ Applying Overlays

Adding blank lines and columns

You can add blank lines and columns.

To add blank lines

Use the vertical selection bar to select the lines to add, then click Blank Lines .

To add blank columns

Use the horizontal selection bar to select the columns to add, then click 
Blank Columns .

Moving and copying text

You can move or copy text from one position in a report to another.

NOTE  
As you perform logical view instructions, the details are listed (sequentially) in the Instruction 
List area.
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To move or copy text

1 Select the area to be moved or copied.

In the example in Figure 22, we are selecting the “Deposit Amount” column 
(currently located to the right of the “Interest Amount” column). 

Figure 22 Selecting text for a move

2 Move or copy the text as follows:

■ To move the text, drag the selection to the beginning row and column of the new 
location. 

■ To copy the text, press the Ctrl key while dragging the selection to the beginning 
row and column of the new location. 

Figure 23 shows the placement of the selection after the move (it is now to the right 
of the “First Name” data). 

Although not required, the beginning row of the new location is generally the 
same row in which the selection began. In our example, we began selection of the 
columns from the third row, and placed the cursor in the third row for the paste.

Note that the details of the instruction are listed in the Instruction List area.
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Figure 23 Logical report view after the move

Hiding an area of the report

When hiding an area of the report, the hidden area does not leave a gap. Instead, the 
area to the right of the hidden area is shifted to the left. If entire rows are selected, 
everything under them is shifted up.

To hide an area

1 Select the area to be hidden.

In the following figure, the Dept No. field has been selected to be hidden.

Figure 24 Hiding an area of the report

2 Click Hide .
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The text in the selected area is no longer displayed. Text to the left of the hidden 
area is shifted to the right, as shown in Figure 25. And the instruction is displayed 
in the Instruction List area.

Figure 25 After the text has been hidden

Freezing margins

Information on a printed page is usually wider or longer than can be displayed at one 
time on a PC screen. The result is

■ report headers, including column (field) labels, generally disappear from sight 
when you scroll down the report

■ important information (for example, account numbers or names) may disappear 
from sight as you scroll the display to the right

Freezing an area prevents the area from disappearing from the window during 
scrolling.

Only one freeze instruction can be defined in a logical view. Therefore, the freezing of 
rows and the freezing of columns must be performed as part of the same instruction.

To freeze margins

Only areas adjacent to the edge of the report can be selected for freezing. It is easiest 
to perform a freeze selection from the edge of a report (using the vertical or horizontal 
selection bar), and move inward. But it is possible to start the selection from inside 
the report and move out to the edge. 
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1 To freeze lines, perform selection in the vertical selection bar as follows:

A To freeze headers, begin selection from the top of the report and move down.

B To freeze footers, begin selection from the bottom of the report and move up.

2 To freeze columns, perform selection in the horizontal selection bar as follows:

A To freeze leftmost columns, begin selection from the left of the report and move 
to the right.

B To freeze rightmost columns, begin selection from the right of the report and 
move to the left.

Figure 26 shows the selection of header lines and the Account Number columns for 
the Freeze operation. 

Figure 26 Selecting column and row text to freeze

3 Click Freeze .

The frozen areas are displayed in grey; they do not scroll. The instruction is listed 
in the Instruction List area.
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Figure 27 Frozen column and row text

Coloring report areas

Color is a very effective tool for distinguishing important information. For example, 
you can use color to

■ highlight header information
■ highlight columns of particular importance
■ highlight information of particular importance
■ distinguish between values or ranges of values

When defining color you can define both text color and background color. You can 
also make colors conditional upon values in selected strings.

To add color to an area

1 Select the desired area, and click Color .

The Color dialog box opens.

2 Select the text and background colors in the Color dialog box (see “Defining colors 
in the Color dialog box” on page 109).

3 If the selected colors should be conditionally applied, click Advanced and define 
the condition that should apply to the colors (see “Defining conditions in the Color 
dialog box” on page 110).

4 Click OK.
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In the example in Figure 28 (which shows the Color dialog box after Advanced has 
been clicked), the following color definitions were selected:

■ Red text
■ Yellow background
■ Condition >9000
■ Condition checked as number
■ Color definition applied to the string

Figure 28 Requesting color

Figure 29 shows the results of the defined Color instructions in the logical view.
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Figure 29 Applied color instructions

Defining colors in the Color dialog box

When you first open the Color dialog box, only the Color Definition section is 
displayed. This section contains the following parts:

■ Background Icon and Text Icon

When defining background or text color,

— First, click on the icon of the item you are defining (background or text) to make 
it current. A red border appears around the currently selected icon.

— Then, click on the particular color you want to apply to the item.

■ Color sets

This area contains the following sets of colors:

— set of 16 colors
— set of 121 colors
— Transparent button (between the two sets of colors)

After clicking on the background or text icon, select a color.
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■ Sample display

After defining the background and text colors, a sample of the resulting 
combination is displayed at the top of the dialog box (to the right of the 
background and text icons).

Defining conditions in the Color dialog box

When you click Advanced in the Color dialog box, the Condition section is displayed. 

The Condition section lets you apply the color definitions conditionally. It contains 
the following items:

■ Condition area

The Condition field has two parts:

— operator selection box
— value specification box

By selecting an operator and specifying a value, you can defined the condition 
required for the colors to be applied. For example, =500.

Valid operators are listed in Table 16. Rules that apply to condition specification 
are listed after the table.

■ As Number check box

If the value of the condition should be treated as a numeric value (when applying 
the operator to the specified value), select this check box.

■ Apply color on field

Lets you specify whether the colors should be applied to the selection string or to 
the entire line in which the selection satisfied the condition criteria.

NOTE  
To specify a color for text only or background only, but not both, click Transparent instead of 
making a color selection for the item that you do not want to change.
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The following rules apply when specifying conditions:

■ You must specify an operator followed by a string.
■ Valid specifications can include numbers, commas, period, plus sign, minus sign, 

and leading or trailing spaces.
■ The number formats must match the formats in the Preferences dialog box.

Masking areas (including and excluding lines)

You can include and exclude lines of a report based on criteria you specify. Any line 
that meets specified criteria is included or excluded as stipulated. Excluded lines are 
blanked out (masked).

A masking criterion consists of an operator and a value (for example, >50).

You can specify compound criteria (joined by AND or OR indicators). For example, 
you could specify compound criteria that select only those people above the age of 20 
and below the age of 40.

You can select up to four areas to mask. 

You must define the selected masking areas in exactly the same order that you want 
the masking criteria applied.

To mask the report

1 Click Mask .

The Mask dialog box opens.

The line numbers and column numbers of the selected areas are displayed on 
successive lines of the dialog box, in the order they were selected.

Table 16 Operator descriptions

Operators Description

= Equal to

<> Not equal to (greater than or less than)

> Greater than

< Less than

>= Greater than or equal to

<= Less than or equal to
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The following formats are used to identify selected line ranges relative to the first 
or last line in the report (where n represents an integer):

Figure 30 Mask dialog box

2 In the Operation box, select either Include or Exclude, depending on whether you 
want the selected area to be included or excluded when criteria are matched.

3 In each row containing selected line and column values, define masking criteria as 
follows:

A In the Operator box, select the mask operator. (For more information, see 
“Masking operators” on page 113.)

B In the value box, specify the mask value. Valid specifications can include 
numbers, commas, period, plus sign, minus sign, and leading or trailing spaces.

C To treat the value as a numeral, select As Number.

D Define AND/OR operators as needed to include additional rows. 

Line Range Description

n Line is counted from the first line of the report. For example, 
5 means the fifth line in the report.

Ln Line is counted from the last line of the report. For example, 
L5 means the 5th line from the end of the report.

NOTE  
The number formats must match the formats in the Preferences dialog box.
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4 When you have finished, click OK.

The report lines are included or excluded according to your masking criteria. 

Figure 30 on page 112 specifies masking criteria that includes any lines that contain 
an interest rate of less than 7.50 and an interest amount greater than 100.

Figure 31 shows the mask applied.

Figure 31 Applied mask criteria

Masking operators

Table 17 lists valid masking operators.

NOTE  
The AND and OR operators do not conform to standard mathematical priorities. They are 
evaluated in the order they are specified and parentheses cannot be used.

Table 17 Operator descriptions

Operators Description

= Equal to

<> Not equal to (greater than or less than)

> Greater than

< Less than

>= Greater than or equal to

<= Less than or equal to
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Applying font changes

You can change the shape, style, and size of characters in the report. These font 
changes can be applied to different areas in the report to indicate or highlight 
important information. For example, if you have a salary report, you can apply the 
bold typeface to the employee number and apply a larger point size to the salary 
amount of highly paid employees. The font attributes remain in effect until new 
attributes are specified.

Font changes can be performed on multiple marked areas simultaneously. 

To perform font changes

1 Select areas (sets of line and columns) to be changed. 

2 Click Font .

The Font dialog box opens.

3 Select a font from the Font box.

4 Select the font size.

5 Click the appropriate buttons as needed to apply bolding, italics, underlining 
and/or strike through. The sequence of buttons is bold (leftmost), italic, underline, 
strike through (rightmost).

6 Click OK.

 Figure 32 shows the report with the requested font changes—the font of the Last 
Name field has been changed to Arial Black. The font for these columns now looks 
different than the font used in the rest of the report.

NOTE  
Changing fonts and font sizes can adversely affect the alignment of report data.

BMC Software recommends that you use a fixed-size font.
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Figure 32 Applied font changes
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Manipulating text
You can manipulate text in the following ways:

■ Hiding repetitive text (displaying unique text)
■ Filling down text in existing columns
■ Adding filled rows and columns (filling text)
■ Adding text

Hiding repetitive text (displaying unique text)

When the same value for a field is repeated in successive lines, you can use the 
Unique command to delete all repetitions that follow the initial occurrence of the 
contiguous set.

To hide repetitive text

1 Select the area in which the repetitions occur (including the first occurrence).

In the example in Figure 33, the Currency field should be made unique. Notice that 
the value US appears successively on many lines.

Figure 33 Before the unique operation

2 Click Unique .

The Unique dialog box is displayed.

By default, repetitious text is removed from all lines even when they are separated 
by blank lines.
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3 Click OK.

Only the first of successive occurrences of the value appears. The repetitions are 
hidden.

Figure 34 shows that all but each first occurrence of “US” has been hidden in the 
report.

Figure 34 After the unique operation

Filling down text in existing columns

Filling down text is basically the opposite of displaying only unique text. The Fill 
Down operation copies the text from columns within a selected area to blank columns 
directly under the text.
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To fill down text

1 Select the area for the Fill Down operation.

In the example in Figure 35, the Currency field needs to be filled down. Notice the 
blanks under the “US” value that appears on the fourth line.

Figure 35 Before the fill down operation

2 Click Fill Down .

The Fill Down dialog box is displayed.

By default, text is filled down on all lines that are not blank, that is, all lines that 
contain a character in any position.

3 To fill down text on all lines, clear the Skip blank lines option.

4 Click OK.

Blanks in the selected area are now filled with the value from the line containing 
information.

Figure 36 shows how the value “US” was filled in.

NOTE  
This feature functions across page breaks.
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Figure 36 After the fill down operation

Adding filled rows and columns (filling text)

Filling text should be distinguished from filling row text. Filling text adds a new area 
to the report and fills it with specified text. Generally, this feature is used to add 
formatting rows and columns to a report. 

For example, you can add a row of dots or dashes between every five data lines, 
which can make it easier to visually scan particular data lines across the page. 
Likewise, you can add a column of vertical dashes between data fields in the report, 
to give the report a more table-like appearance. 

Filling text can be performed only on one selected area at a time, but it can be 
performed as often as required. 

When adding formatted rows, you select a full row (by clicking in the vertical 
selection bar). When adding formatted columns, you begin at a point in the column 
(such as the top row), and continue down to the bottom of the column. However, it is 
possible to select partial rows and columns as long as the selected area is contiguous.

Selected rows are moved down. Selected columns are shifted right.

Filling text is similar to adding text, except that it fills the entire selected area 
(columns and rows) with the specified text.

NOTE  
Although the example above used the Fill Down operation to reverse a previous Unique 
operation, Fill Down can be performed on any blank area (without a previous Unique 
operation having been performed).
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Filling text differs from filling down text in the following ways:

■ Filling text uses text you supply; filling down text uses text appearing in the 
selected area.

■ Filling text shifts the original text in the selected area to the right; filling down text 
does not shift text.

To fill text

1 Select an area and click Fill Text .

The Fill Text dialog box opens.

2 Type text in the dialog box.

In Figure 37, a row containing dots is added after the fifth line in the report. 
Though we specified several dots so they would stand out in the illustration, it was 
really only necessary to specify one dot in the Fill Text dialog box.

Figure 37 Before the fill text operation

3 Click OK.

In Figure 38, note that the record that was originally selected was moved down.
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Figure 38 After the first fill text operation

Figure 39 shows the report after several Fill Text operations.

Figure 39 After several fill text operations

Adding text

Adding text to an area is different than filling text or filling down text in the following 
ways:

■ Adding text adds the exact specified text to the specified area (and text to the right 
of the added text is shifted to the right).

■ Adding text can be used to add blank lines or columns to the report area.
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■ Filling text repeats specified text so that it fills the entire selected area.

■ Filling down text copies text into the corresponding empty columns below it.

To add text

1 Select an area and click Text .

The Text dialog box opens.

2 Type the desired text in the Text dialog box

Figure 40 shows that the word Confidential should be added under the report title.

Figure 40 Adding text in the Text dialog box

3 Click OK.

The requested text is added in the selected location. The text to the right of the 
selected area is shifted to the right.

Figure 41 After adding text
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Applying dynamic definition labels

Dynamic logical views enable report viewers to customize the appearance of report 
data in a logical view without changing the instructions in the Instruction List. 

Dynamic logical views work as follows:

■ The logical view is defined in the usual manner (moving, hiding, coloring, and so 
on).

■ Labels are applied to data columns (for example, Last Name), one column at a time 
(as described below). 

■ When a logical view that contains at least one Label parameter is saved, the logical 
view is automatically saved as a “dynamic” logical view.

When viewing a report using a dynamic logical view, you can customize the display 
of those columns for which a Label has been defined, without changing the logical 
view instructions. For more information, see “Using dynamic logical views” on 
page 57.

Note the following about defining labels:

■ Labels can be applied to one, many, or all columns, as needed.

■ Label instructions should be defined in a contiguous sequence. Other logical view 
instructions can be defined before or after the group of label instructions, but 
should not be defined between them.

To apply a label

1 Select the area and click Label .

The Label dialog box opens.

2 In the Type selection box, select String or Numeric to identify the type of data.

3 Type a label (name) in the Identifier definition box.

4 Click OK.

The specified label now applies to the selected area. Repeat this process for all 
columns for which a label is required.
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Applying overlays

Overlays are graphic files (usually transparent) that can be placed in a report to 
enhance its aesthetics. Graphic overlays can serve many different purposes. For 
example, you can

■ place a logo or other graphic in a blank area in the report foreground.

■ place a logo or other transparent graphic (watermark) in the report background

■ place a table-like grid on a report to clearly delineate columns

The Overlay function can be used to include graphics in GIF or JPG formats. Your 
WebAccess Server administrator determines which overlays are available at your site 
and places them in a single, easily accessible location.

When using the Overlay function, you must specify the URL of the file you want to 
include.

To include an overlay

1 Click Overlay .

The Overlay dialog box is displayed.

2 In the URL definition box, type the URL of the graphic file you want to include

If the report page is longer than the physical page, the report information is 
printed on multiple pages. To print the overlay on each physical page, select Print 
on each page. 

3 Click OK.

The graphic is included in all the pages in the report. 

Figure 42 shows inclusion of an overlay in the report. Note that you cannot see the 
report text. This is because when the overlay was included, it was included into the 
foreground of the report.

NOTE  
When working with SSL (in other word, HTTPS), you can either specify the URL relative to 
the Internet access method virtual folder or specify, using HTTP, the full path to any other 
external server containing the overlay. Specifying the full path to an external server using 
HTTPS causes the Logical View Editor to stop functioning. For more information, consult 
your WebAccess Server administrator.
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Figure 42 Requested overlay included in a report view

The Overlay function has its own pop-up menu. You can use this menu to move 
the overlay to the background. 

4 Right-click your mouse anywhere in the Overlay display.

The Overlay pop-up menu is displayed.

5 Choose Send Behind Text.

The overlay now appears in the background of the report, and the report text is 
visible in the foreground.

Figure 43 Overlay in background and text visible

NOTE  
Ensure that the text background is transparent, otherwise it hides the overlay.
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Adjusting the size of the overlay

You can adjust the size of the Overlay to fit any portion of the report page. To adjust 
the overlay, click on the appropriate border edge and drag it in the necessary 
direction. 

Figure 44 shows the bottom border edge of the overlay.

Figure 44 Bottom border edge of the overlay

Figure 45 shows the overlay after it has been adjusted

Figure 45 Overlay after it has been adjusted

Selecting text when an overlay is inserted

To select text (for example, for a move or copy) when an Overlay has been inserted, 
you must let the Logical Editor know that you are selecting the text, not the overlay. 

You do this by clicking Select Overlays before performing the selection. The Select 
Overlays button toggles between Overlay mode and Text mode. When in Text mode, 
you can select text.
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To select text if an overlay is inserted

1 Click Select Overlays .

The Select Overlays button now displays text characters  indicating that it is in 
Text mode.

2 Make the selection.

Figure 46 shows an area selection in the presence of an Overlay.

Figure 46 Text selection with an overlay

3 Perform the necessary operation (move, copy, and so on) on the selected text.

4 When you are done, you can click Select Overlays to toggle back to Overlay mode.

Working with multiple overlays

You can work with multiple overlay files in the same report. However, you can only 
work with one overlay at a time. The Overlay pop-up menu lets you set the order of 
overlays.

To understand how to use the overlay options, it is helpful to think of multiple 
overlays as being stacked at different levels, as follows:

■ Consider the report text as residing on level zero.
■ Consider foreground overlays to be above the zero (text) level.
■ Consider background overlays to be below the zero (text) level.
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To access the Overlay pop-up menu

1 From the last instruction in the instruction list, click Select Overlays.

2 Select an overlay and right-click it.

Table 18 describes the options available from the Overlay pop-up menu, in terms 
of the above concepts.

Exporting a report to an Excel file
You can export a report to a Microsoft Excel file by performing the following tasks: 

■ requesting a spreadsheet view of the report

■ defining and editing the spreadsheet view, which is similar to defining a logical 
view and includes the following tasks:

— adjusting the columns on the spreadsheet view

— if desired, excluding unwanted information (columns or lines) from the report

If you mistakenly excluded lines or columns, you can re-include them.

— assigning the report data to cell types (Label, Number, Date, Time)

■ saving the spreadsheet view

These tasks are described below.

Table 18 Overlay pop-up menu options

Option Description

Bring to Front Brings the overlay closest to the text level.

Send to Back Moves the overlay furthest from the text level.

Bring Forward Brings the overlay one level closer to the text level.

Send Backward Moves the overlay one level further from the text level.

Bring in Front of Text Moves the Overlay from the background to the foreground. The text 
is hidden (behind) the overlay.

Send Behind Text Moves the Overlay from the foreground stack to the background. 
The text appears, with the Overlay seen as background.
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As with a logical view, once the spreadsheet view for a report has been defined, it is 
can be used for all subsequent updated copies of the report (provided that the data 
format does not change). 

Once a spreadsheet view has been prepared and saved, the spreadsheet view of the 
report can be exported and opened in Microsoft Excel.

To request a spreadsheet view of a report

Click Export .

A spreadsheet image is opened over the report in the Report View (Figure 47). The 
spreadsheet columns might not be properly aligned with the fields of the report. 

Figure 47 Report file exported to a spreadsheet file

The buttons to the left of the spreadsheet are different from logical view buttons.

The spreadsheet buttons are described in Table 19.

NOTE  
The instruction list area is not displayed during export definition activities.
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To adjust the columns of the spreadsheet view

Starting from the leftmost column of the report, adjust the size of the columns of the 
spreadsheet to fit the fields in the report. Be sure to scroll to the right so as to adjust all 
columns in the report.

By default, spreadsheet cells are treated as labels and columns have a width of ten 
characters.

Note that to adjust the spreadsheet column size, you use the same technique that you 
would use in any spreadsheet: You click on the border between two cells and slide 
the border to the appropriate location.

Figure 48 shows the file after it has been adjusted. 

Figure 48 Spreadsheet columns adjusted to fit report fields

Table 19 Side buttons of the spreadsheet view

Button Edit Description

Clear All 
Definitions

Clears all instructions and changes. 

Format Cells Assigns data types and formats to spreadsheet cells.

Exclude Excludes unwanted lines or columns from the spreadsheet. 

Include Cancels the “Exclude” function on the specified lines or 
columns so that these lines or columns are re-included.
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To exclude unwanted information

1 Select the unwanted columns or lines.

2 Click Exclude .

A red X symbol is placed in the line number box of excluded lines, and in the 
spreadsheet column box of excluded columns.

In Figure 49, the second line from the top (the blank title line) was excluded. This 
line is no longer included in the line count. Instead, the line number box for this 
line contains a red X. If this report is later opened in Excel, this line does not 
appear.

Figure 49 Line excluded from spreadsheet view

To re-include previously excluded information

1 Select the lines or columns you want to re-include.

2 Click Include .

The red X symbol by the line or column is deleted.

The Include button only affects lines or columns that are excluded.

To assign cell types

Follow the instructions detailed in “Assigning spreadsheet cell types” on page 132.
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To clear all definitions from the spreadsheet view

Click Clear All Definitions .

All definitions are removed from the spreadsheet view. The spreadsheet can now be 
edited from scratch.

To save a report as a spreadsheet

1 Click Save .

The Save As dialog box opens. 

2 In the Logical View Name field, specify the name you want assigned to the export 
file. 

3 To make the export definition available to a group of reports, specify the mask and 
wildcard for the group in the Report Mask field. For example, if Currency* is 
specified in the Report Mask field, the export definition is available for reports 
called Currency-Dollars, Currency-Euros, and so on.

4 Ensure that the Save export definition check box is checked.

5 Click OK.

The spreadsheet logical view is saved.

Assigning spreadsheet cell types

The most important definitions in the spreadsheet view are cell types. The four valid 
cell types are described in Table 20.

General instructions for assigning cell types are provided immediately below. These 
are followed by instructions for specific situations.

Table 20 Valid cell types

Cell type Description

Label Used for cells containing alphanumeric values.

Number Used for cells containing numeric values.

Date Used for cells containing date values.

Time Used for cells containing time values.
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To format cells in the spreadsheet view (general instructions)

1 Select the cells that you want to format. (You can select more than one cell if the 
selected cells are of the same type.)

2 Click Format Cells  or double-click on the cells that you want to format.

The Format Cells dialog box is displayed. 

The left side of the Format Cells dialog box contains the fields described in Table 21.

The contents of the right side of the dialog box change depending on the cell type you 
select.

In the Format Cells dialog box, select the cell type you want to assign to your selected 
cells as described in Table 20 on page 132. The contents of the dialog box changes 
accordingly.

If you want the data in the cells protected, check the Protected box.

If you only want the first page of the report to be exported, check the First Page only 
box.

Make the necessary entries in the right side of the dialog box according to cell type. 

For a description of the fields on the right side of the dialog box, see “Formats of 
fields specific to individual cell types” on page 135.

3 After selecting values for all the necessary fields, click OK.

Note the following points:

■ Spreadsheet columns containing numeric values should not necessarily be 
considered numeric. You might want to assign a Label cell type to numeric 
values that are left justified and are not used for numeric calculations (for 
example, room number).

Table 21 Fixed fields of the Format Cells dialog box

Field Usage

Cell Type Specify (select) the type of information contained in the cells as 
described in Table 20.

Protected Check this box if you want the data in the cells to be protected from 
modification.

First Page Only Check the box if you want to export only the values on the first 
report page. This is useful for exporting headings.
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Ultimately, you should assign them the same cell type that you would assign to 
them in Excel.

■ Report titles and column header information are generally labels 
(alphanumeric), even if the report data has a different type (for example, date). 
Therefore, it is advisable to assign column header and column data cell types 
separately.

■ If all column header rows are of type label, you can assign those rows their cell 
type in a single step.

■ Report title information frequently spans more than one spreadsheet column. 
You should check the Single cell check box in the Format Cells dialog box when 
this occurs.

Recommendations for handling report titles and column headers are provided 
immediately below.

To assign cell types to title lines and column headers

1 Select the title lines and column headers.

2 Click Format Cells.

The Format Cells dialog box is displayed. 

Note that Label and Left Justified are already selected. You probably do not want to 
change these values.

3 Do not forget to check the Protected and First Page Only boxes if necessary.

4 Click OK.

Figure 50 shows a header line around the area you have just defined.

Figure 50 Header lines around cell definitions

To format report title lines that span more than one spreadsheet cell

Select Single Cell and click OK.

The result is shown in Figure 51.



Formats of fields specific to individual cell types

Chapter 6 Managing logical views 135

Figure 51 Title line following cell spanning definition

Formats of fields specific to individual cell types

The entry fields on the right side of the Format Cells dialog box change according to 
the selected cell type. The fields according to cell type are described below.

Table 22 Fields specific to the label cell type

Field/area

Selection values Description

Label Format Format assignment for an alphanumeric (string) cell

Left Justified Aligns text to the left

Right Justified Aligns text to the right

Centered Centers the text

Repeated Repeats the text through the selected area

Single Cell Exports selected block as a single cell, without regard to the 
vertical grid lines

Table 23 Fields specific to the number cell type

Field/area

Selection values Description

Number Format Format assignment for a numeric cell

Fixed Rounds off values to the number of decimal places specified 
in the Decimal Places field.

Scientific Displays numbers in scientific notation (for example, 
2.35E+2)

Currency Displays numbers in currency format (for example,$500.99)

Comma Separates thousands with a comma and displays negative 
numbers in parentheses (for example, 100,000)

Percent Displays the number as a percent (for example, 80%)

General Uses the default format

Decimal Places Number of places to be displayed to the right of the decimal 
point—for Fixed field only.
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Table 24 Fields specific to the date cell type

Field/area

Selection values Description

Date Format assignment for a date cell

DD/MMM/YY Day/month/year (for example, 26/SEP/00)

DD/MMM Day/month (for example, 26/SEP)

MMM/YY Month/year (for example, SEP/00)

Short International Month/day (for example, 09/00)

Long International Month/day/year (for example, 09/26/00)

Decoding Mask Format that the Logical View Editor uses to read the date 
from the report. Ensure that the decoding mask matches the 
date format in the report. For example, if the date in the 
report is “14.05.2002,” the decoding mask should be 
“DD.MM.YYYY.” Default: MM/DD/YY

Table 25 Fields specific to the time cell type

Field/area

Selection values Description

Time Format Format assignment for a time cell

hh:mm:ss AM/PM Hour:minute:second using a 12-hour clock (for 
example, 06:45:23 PM)

hh:mm AM/PM Hour:minute using a 12-hour clock (for example, 06:45 PM)

Short international Hour:minute using a 24-hour clock (for example, 18:45)

Long International Hour:minute:second using a 24-hour clock (for 
example, 18:45:23)

Decoding Mask Format that the Logical View Editor uses to read the time 
from the report. Ensure that the decoding mask matches the 
time format in the report. For example, if the time in the 
report is “18.37,” the decoding mask should be “HH.MM.” 
Default: HH.MM



Appendix A Display types 137

A p p e n d i x A
A  Display types

Display types determine the report attributes (such as the number of pages in a report 
or a report’s expiry date) that are displayed for each report in the Report List 
window. 

Display types
The following table contains names (titles or column headings) that can be configured 
by the CONTROL-D/WebAccess Server administrator to be displayed in the Report 
List window. The administrator can change the default titles. The titles are also 
displayed in the Property fields of the Properties window.

Table 26 Display types (part 1 of 4)

Default title Description

Backup Indicates if the report was backed up.

Category Category name (site-defined term, for example, DAILY, 
MONTHLY).

Chars Unique four-letter identification of the report’s ASCII translation 
file (for example, ascii.cvt).

Checked Out By Displays the name of the user who checked out a report from a 
CONTROL-D for Distributed Systems repository.

Check-Out Status Indicates if a report has been checked out of a CONTROL-D for 
Distributed Systems repository.

Class Mainframe printing class (for Mainframe repository reports only)

Copies Preset number of copies to be printed.

Decollation Date Date that the report was decollated (processed for distribution).

Decollation Time Time that the report was decollated (processed for distribution).

Dest Required host printer JES destination for printing the report. 
Special destination codes CTDPC and CTDPCPRT (specified in 
mainframe CONTROL-D) direct the output from the mainframe 
for downloading to a PC.
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Email Displays the email icon to enable opening of the Email window.

Enable Text Search Indicates whether Full Text Search capabilities are to be enabled 
for this report. (Yes/No) 

Encoding The encoding used when the report is viewed
(for example, Latin1 or Hebrew are encoded in legacy; UTF-8 is 
encoded in Unicode).

Note: Encoding maps specific byte values in the report to the 
letters they represent. The appropriate encoding of a report must 
be used to view the text correctly. Usually encoding also implies a 
specific language. However, some encoding, such as UTF-8, 
applies to multiple languages and therefore the Language 
attribute must be used for selecting the correct font.

Expiration Date Date from which CONTROL-D/Repository Server can delete the 
report from the CONTROL-D for Distributed Systems repository.

File Ext. The report file’s extension (for example, .doc, .pdf, .txt).

Final Displays whether the report version is final, that is, whether other 
versions can be created (Yes/No). 

Form Form used when printing a report on a mainframe printer. (For 
mainframe CONTROL-D printing.)

From User Name of the user from which this report (or part) has been 
received. (For mainframe CONTROL-D.)

Generation Generation number of the report, determined by the 
administrator. A report with the same name can have several 
generations stored in the CONTROL-D for Distributed 
Systems repository. 

Is Last Version Indicates whether the document is final and can no longer be 
checked out from a CONTROL-D for Distributed Systems 
repository.

Job End Date Date the job was ended.

Job End Time Time the job was ended.

Job ID Numeric part of the job ID that created the report.

Job Name Name of the job that created the report.

Job Start Date Date the job was started.

Job Start Time Time the job was started.

Language The language of the report. (for example, English or Chinese).

Lines Number of lines in the report.

Location Describes report status: Active, History, or Migrated.

Order Date Date the report was created or scheduled to be run.

Table 26 Display types (part 2 of 4)

Default title Description
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Original Encoding The encoding of the report as stored on the mainframe.

Note: Encoding maps specific byte values in the report to the 
letters they represent. The appropriate encoding of a report must 
be used to view the text correctly. Usually encoding also implies a 
specific language. However, some encoding, such as UTF-8, 
applies to multiple languages and therefore the Language 
attribute must be used for selecting the correct font.

Page List Mode Describes whether the report was decollated in page mode or 
document mode.

Pages Number of pages in the report.

Print Opens a pop-up menu that enables the print options.

Properties Displays the report properties icon that enables opening the 
Report Properties window.

Recfm Record format for mainframe reports.

Recipient Report’s owner.

Remark 2 Free text remark about the report. This parameter is available in 
document repositories of CONTROL-D for z/OS version 6.2.16 
and later.

Remark 3 Free text remark about the report. This parameter is available in 
document repositories of CONTROL-D for z/OS version 6.2.16 
and later.

Remark CC Condition code and/or remark. Highest condition code from the 
job execution, or other job termination codes, including system or 
user abend codes, NCT2 (NOT CATLGD 2), or JFAIL (JCL error).

Report Icons (no title 
displayed)

Icons that identify the viewer or application associated with a 
report displayed in the column at the left of the Report List 
window.

Report Name Name of the report.

Resource Set ID Time stamp that identifies the set of resources used by a report 
during decollation.

Save Lets all or part of a report be saved locally.

Status Status of the report at import time. For an explanation of 
mainframe report statuses, see the CONTROL-D User Manual.

Text Search Ready Indicates whether Full Text Search is enabled for this report. 
(Yes/No) 

Transfer Date Indicates the date the report was transferred to the CONTROL-D 
Repository.

Transfer Time Indicates the time the report was transferred to the CONTROL-D 
Repository.

Type Indicates whether the report is binary or text.

Table 26 Display types (part 3 of 4)

Default title Description
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User Dest The second part of the report’s DEST sysout parameter.

Version Report version number. CONTROL-D for Distributed Systems 
repository reports can have several versions. A version is created 
by checking out and checking in a report.

Table 26 Display types (part 4 of 4)

Default title Description
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A p p e n d i x B
B  Error messages

This appendix contains explanations of the messages issued by CONTROL-
D/WebAccess Server. The following information is provided for each message:

■ Explanation explains the reasons why WebAccess Server issued the message.

■ System Action describes what WebAccess Server does as a result of encountering 
the situation.

■ User Response describes what you should do in this situation.

All messages produced by WebAccess Server consist of the following elements:

■ A message identifier 

■ A severity code that indicates the nature of the message and the level of action 
required by the user 

■ The message text

For example:

BMCSII0011E Internal error occurred while transferring request error description

In this example:

■ SII0011 is the message identifier.

■ E is the severity code.

■ Internal error occurred while transferring request error description is the text of the 
message.

Italicized words indicate variable text that is determined when the message is issued.
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Message codes and text
Table 27 describes the severity codes issued with messages.

BMCSII0010E Streaming error occurred while transferring request:error message, description

Explanation:  Server Interface cannot transfer a request due to network errors.

System action:  Requests cannot be processed.

User response:  Contact the network administrator.

BMCWAS2402S CONTROL-D Web Access Server system configuration problem

Explanation:  The WebAccess Server configurations have not been found. 

System action:  The user cannot enter the reports from the Reports List screen. 
The user is returned to the Login screen.

User response:  Run Desktop and resave WebAccess Server configurations.

BMCWAS2403S Invalid Session ID, Please login again

Explanation:  The user is attempting to use a session ID that is no longer valid. 
This can happen because the time out period was reached, if a user logged out 
and then clicked “Back” in the browser, or if Server Interface (or WebAccess 
Server if Server Interface is running as a DLL) was restarted after the user 
logged in.

System action:  The user cannot access WebAccess screens.

User response:  Check your Server to ensure that it did not fail. Login using the 
correct user ID and password for the Session ID (for example, A, B) and specify 
the correct values in the Session 

BMCWAS2404S Inaccessible Report

Explanation:  A problem occurred during a Report request. 

System action:  The error also prompted an error message in the application 
where the error occurred.

User response:  Follow the directions found in the application’s error message.

Table 27 Message severity codes

Code Meaning

E (error) The requested function was not completed.

I (information) This is an information message. No action is required.

S (system) A system error occurred.

W (warning) The system is still operating, and no immediate action is 
required.
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BMCWAS2405S Inaccessible Index information

Explanation:  A problem occurred while opening a Report Index. The error also 
prompted an error message in the application where the error occurred.

System action:  None.

User response:  Follow the directions found in the application’s error message.

BMCWAS2406S Inaccessible Index Value information

Explanation:  A problem occurred while setting a value to an Index request. The 
error also prompted an error message in the application where the error 
occurred.

System action:  None.

User response:  Follow the directions found in the application’s error message.

BMCWAS2407S Login Failed

Explanation:  The application did not recognize the login. The MF or DS 
repository generates a message indicating why the login failed.

System action:  The user cannot enter CONTROL-D/WebAccess screens.

User response:  Enter the correct user ID and password.

BMCWAS2408S Inaccessible Location information

Explanation:  A problem occurred accessing information from the user’s location. 
The error also prompted an error message in the application where the error 
occurred.

System action:  None.

User response:  Follow the directions found in the application’s error message.

BMCWAS2409S Inaccessible Note List information

Explanation:  A problem occurred while accessing the Report Note List. The 
error also prompted an error message in the application where the error 
occurred.

System action:  None.

User response:  Follow the directions found in the application’s error message.

BMCWAS2410S Inaccessible Note information

Explanation:  A problem occurred while opening a Report Note. The error also 
prompted an error message in the application where the error occurred.

System action:  None.

User response:  Follow the directions found in the application’s error message.
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BMCWAS2411S Inaccessible Logical view information

Explanation:  A problem occurred while accessing the Logical View feature. The 
error also prompted an error message in the application where the error 
occurred.

System action:  None.

User response:  Follow the directions found in the application’s error message.

BMCWAS2412S Inaccessible Report List information 

Explanation:  Problem with the connection between the Server Interface and 
CONTROL-D/WebAccess Server.

System action:  Returns to the previous window.

User response:  Check the connection or contact the system administrator.

BMCWAS2413S Add Note Failed.

Explanation:  Server Interface was not able to add a note. No space is left on the 
disk, the user is not authorized to add a note, or the connection to the server 
failed.

System action:  Return to the main CONTROL-D/WebAccess Server window.

User response:  Contact your system administrator.

BMCWAS2414S Failed to update report fields. 

Explanation:  Updateable field could not be updated. This field does not support 
updating.

System action:  The field does not change.

User response:  Contact your system administrator.

BMCWAS2415S Add Global Note Failed.

Explanation:  General note cannot be added. No space is left on the disk, the user 
is not authorized to add a note, or the connection to the server failed.

System action:  The General note is not updated.

User response:  Contact your system administrator.

BMCWAS2418S Inaccessible Folder information.

Explanation:  A problem occurred during a Folder request.

System action:  The error also prompted an error message in the application 
where the error occurred.

User response:  Follow the directions found in the application’s error message.
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BMCWAS2419S Report Check-Out Failed.

Explanation:  Failed to check out a report.

System action:  The report is not checked out.

User response:  Contact your system administrator.

BMCWAS2420S Report Check-In Failed.

Explanation:  Failed to check in a report.

System action:  The checked-out report is not checked in.

User response:  Contact your system administrator.

BMCWAS2421S Revert Report Failed.

Explanation:  Failed to revert a report to its previous version.

System action:  A checked-out report is not reverted to its previous version.

User response:  Contact your system administrator.

BMCWAS2422S Create Report Failed.

Explanation:  Failed to create a new report.

System action:  A new report is not created.

User response:  Contact your system administrator.

BMCWAS2423S Delete Report Failed

Explanation:  Failed to delete a report.

System action:  The report is not deleted.

User response:  Contact your system administrator.

BMCWAS2424S Authenticate Failed.

Explanation:  The user login (authentication) via the Predefined Locations Login 
window failed.

System action:  User login fails.

User response:  Verify your user name and password and try to log in again.

BMCWAS2425S Failed to update report fields. Field field needs to be a number greater than zero. 

Explanation:  The report field could not be updated because the new number is 
not greater than zero.

System action:  The report field is not updated.

User response:  Enter a number greater than zero and try updating the field 
again.



Message codes and text

146 CONTROL-D/WebAccess Server User Guide

BMCWAS2426S Add Note Version Failed.

Explanation:  Failed to add a new version of a note.

System action:  The new note version is not added.

User response:  Contact your system administrator.

BMCWAS2427S Inaccessible Transformer List Information

Explanation:  The transformer list cannot be accessed.

System action:  The transformation request is not completed.

User response:  Contact your system administrator.

BMCWAS2600E Please enter full date format.

Explanation:  The date format was entered incorrectly. Part of the date format 
(dd/mm/yyyy) was left blank.

System action:  None.

User response:  Correct the date format and re-enter the information.

BMCWAS2601E A User Name must be specified in order to log in to a location

Explanation:  A user name was not entered in the User Name field of the Login 
window. User Name is a mandatory field.

System action:  The user cannot enter the system.

User response:  Enter a correct (authorized) user name and re-try the login 
procedure.

BMCWAS2602E Password not Confirmed

Explanation:  System does not accept the password. An invalid password was 
entered.

System action:  The password change was not accepted.

User response:  Enter a different valid password.

BMCWAS2603E New Password is a MANDATORY FIELD. Please enter the Password and click 
Login.

Explanation:  The New Password in the Change Password window was left 
blank. New Password is a mandatory field.

System action:  Password change cannot be completed until a new password is 
entered.

User response:  Enter a new password.
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BMCWAS2604E You must specify an Index Name if you specify an Index Value.

Explanation:  Index value was specified in the filter window but no index name 
was provided. The Index Name is a required field when an index value is 
specified.

System action:  The error is highlighted and the field is marked. The user cannot 
input new fields until this field is corrected.

User response:  Enter an index name.

BMCWAS2605E Invalid Date.

Explanation:  The date format was entered correctly but the number was too 
large (the month value was greater than 12 or the day value was greater than 
31).

System action:  None.

User response:  Correct the date and re-enter the information.

BMCWAS2606E Invalid time range.

Explanation:  The same date was entered in the “Date From” and “Date To” 
fields, so that the date range defines exactly one day, but one of the time values 
was entered incorrectly so that the value in the “Time From” field is greater the 
value in the “Time To” field.

System action:  None.

User response:  Correct the time and re-enter the information.

BMCWAS2607E Invalid date range.

Explanation:  The From field is greater than the To field. The To field must be 
greater than the From field.

System action:  The error is highlighted and the field is marked. The user cannot 
input new fields until this field is corrected.

User response:  Correct the date and re-enter the information.

BMCWAS2608E Invalid time format
Format is HH:MM or HH:MM:SS
HH=00-23 MM=00-59 SS=00-59.

Explanation:  The Time field was entered incorrectly. The format must be hh:mm 
or hh:mm:ss where hour values must be 0-23, minute values must be 0-59, and 
second values must be 0-59.

System action:  The error is highlighted and the field is marked. The user cannot 
input new fields until this field is corrected.

User response:  Correct the time and re-enter the information.
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BMCWAS2609E Invalid page number specified or Page Number exceeds the number of pages in 
the report.

Explanation:  Incorrect value was entered in the GoTo field. The GoTo value 
must be a number that is less than or equal to the length of the report.

System action:  The error is highlighted and the field is marked. The user cannot 
input new fields until this field is corrected.

User response:  Correct the page number and re-enter the field.

BMCWAS2610E Invalid Date format
Please enter 2 digits for both day and month - and 4 digits for year
separated by a /, or use today format.

Explanation:  Date format was entered incorrectly. The special format of the Date 
From or Date To fields was incorrectly entered.

System action:  None.

User response:  Correct the date format and re-enter the information.

BMCWAS2611E Date must be numerical. 
Please enter 2 digits for both day and month - and 4 digits for year
separated by a /, or use today format.

Explanation:  The Date format only supports dates expressed numerically. The 
special format of the Date From or Date To fields was incorrectly entered.

System action:  None.

User response:  Correct the date format and re-enter the information.

BMCWAS2612E A User Name must be specified in order to log in to a location

Explanation:  A user name was not entered in the User Name field of the Login 
window. User Name is a mandatory field.

System action:  The user cannot enter the system.

User response:  Enter a correct (authorized) user name and re-try the login 
procedure.

BMCWAS2613E A name must be specified for the new note.

Explanation:  The title field of a new note was left blank. A note title is required.

System action:  The new note is not added.

User response:  Enter a note title.

BMCWAS2614E Note text must be entered for the new note/version.

Explanation:  The note text of a new note was left blank. Note text is required.

System action:  The new note is not added.
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User response:  Enter the note text.

BMCWAS2616E Note coordinates in the page must be selected for the note.

Explanation:  A new note was entered. The report area associated with the note 
was not defined. Note coordinates is a required field.

System action:  The new note is not added.

User response:  Enter the note coordinates.

BMCWAS2617E A Form can be 8 characters only and can include only [a-z], [A-Z], [0-9], @, #, $.

Explanation:  Invalid Form value was specified in the Host Print window. The 
Form field must only be eight characters long.

System action:  The report is not printed.

User response:  Correct the error in the Form field and re-enter the information.

BMCWAS2618E A Class can be one char only and can include only [a-z], [A-Z], [0-9].

Explanation:  Invalid Class value was specified in the Host Print window. The 
Class field consists of only one character.

System action:  The report is not printed.

User response:  Correct the error in the Class field and re-enter the information.

BMCWAS2619E A ruler can be 8 characters only.

Explanation:  Invalid Ruler value was specified in the Host Print window. The 
Ruler field can contain only eight characters.

System action:  The report is not printed.

User response:  Correct the error in the Ruler field and re-enter the information.

BMCWAS2620E Invalid #today format 
Format is #today [-number].

Explanation:  The “#Today plus format” key word was entered incorrectly. The 
special format of the Date From or Date To fields was entered incorrectly.

System action:  None.

User response:  Correct the error in the field and reenter the information.

BMCWAS2621E Note name must not exceed 20 characters.

Explanation:  In Legacy mode, the number of characters in the note name is 
greater than 20 for a Distributed Systems repository or greater than 40 for a 
Mainframe repository.

System action:  The note is not added.

User response:  Enter a note name with the appropriate number of characters.
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BMCWAS2621Ea Note name is too long.

Explanation:  In Unicode mode, there are too many characters in the note name.

System action:  The note is not added.

User response:  Enter a note name with fewer characters.

BMCWAS2622E Note text must not exceed 560 characters.

Explanation:  The number of characters in the note text is greater than 560.

System action:  The note is not added.

User response:  Enter note text of less than or equal to 560 characters.

BMCWAS2623E A Destination can be 8 characters only and can include only [a-z], [A-Z], [0-9], @, 
#, $.

Explanation:  Invalid Destination value was specified in the Host Print window. 
The Destination field must only be eight characters long; only certain characters 
are permitted.

System action:  The report is not printed.

User response:  Correct the error in the Destination field and re-enter the 
information.

BMCWAS2624E You must specify at least one location: Active, History, or Migrated

Explanation:  A location has not been selected.

System action:  The report list is not filtered.

User response:  Select an active, history, or migrated location.

BMCWAS2625E Number of Index Names must be equal or greater than number of Index Values.

Explanation:  The number of index names entered is not equal to or greater than 
the number of selected values.

System action:  The report list is not filtered.

User response:  Re-enter index names and/or index values.

BMCWAS2626E Can not have empty index names.

Explanation:  You have entered index values but no index names.

System action:  The report list is not filtered.

User response:  Enter one or more index names (that are equal to or greater than 
the number of index values).

BMCWAS2627E You must check at least one report type: Text, AFP, Xerox, PDF, or Other.

Explanation:  A report type has not been selected.
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System action:  The report list is not filtered.

User response:  Select one or more report types.

BMCWAS2628E Version must be ‘#last’, ‘#all’, or a number.

Explanation:  An invalid value has been entered in the Version field.

System action:  The report list is not filtered.

User response:  Select #last or #all, or enter a version number.

BMCWAS2629E Generation must be a number or empty.

Explanation:  An invalid value has been entered in the Generation field.

System action:  The report list is not filtered.

User response:  Enter a generation number, or leave the generation field empty.

BMCWAS2632E A FromPage can be numerical only.

Explanation:  An invalid character has been entered in the From Page field.

System action:  The report is not printed.

User response:  Enter a numerical value in the From Page field.

BMCWAS2633E A ToPage can be numerical only.

Explanation:  An invalid character has been entered in the To Page field.

System action:  The report is not printed.

User response:  Enter a numerical value in the To Page field.

BMCWAS2634E Maximum page is [number].

Explanation:  The value entered in the To Page field is greater than the number 
of pages in the report.

System action:  The report is not printed.

User response:  Enter a To Page value equal to or less than the number of pages in 
the report.

BMCWAS2635E FromPage cannot be greater than ToPage

Explanation:  The From Page value is greater than the To Page value.

System action:  The report is not printed.

User response:  Re-enter a From Page value that is less than the To Page value.

BMCWAS2636E Selected index is unavailable.

Explanation:  No values exist for the selected index name.
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System action:  The error is highlighted and the field is marked. The Index Values 
field is set to empty.

User response:  Choose a different index name.

BMCWAS2637E A Writer can be 8 characters only and can include only [a-z], [A-Z], [0-9], @, #, $.

Explanation:  Invalid Writer value was specified in the Host Print window. The 
Writer field can contain only eight characters.

System action:  The report is not printed.

User response:  Correct the error in the Writer field and re-enter the information.

BMCWAS2638E A File name must be specified in order to create a new report.

Explanation:  The File name is a required field to create a new report.

System action:  The error is highlighted and the field is marked. The user cannot 
create a new report until this field is corrected.

User response:  Enter a file name.

BMCWAS2639E A File name must be specified in order to check in a report.

Explanation:  The File name is a required field to check in a report.

System action:  The error is highlighted and the field is marked. The user cannot 
check in a report until this field is corrected.

User response:  Enter a file name.

BMCWAS2640E A Report name must be specified in order to create a new report.

Explanation:  The Report name is a required field to create a new report.

System action:  The error is highlighted and the field is marked. The user cannot 
create a new report until this field is corrected.

User response:  Enter a report name

BMCWAS2641E The report list cannot be sorted by a field more than once.

Explanation:  This field was chosen in a previous line.

System action:  The error is highlighted and the field is marked. The user cannot 
apply a report list sort until this field is corrected.

User response:  Choose a correct field.

BMCWAS2642E The Low Value must be numeric.

Explanation:  The Low Value is not numeric. This is a required field to apply a 
dynamic logical view.

System action:  The error is highlighted and the field is marked. The user cannot 
apply a dynamic logical view until this field is corrected.
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User response:  Enter a correct number.

BMCWAS2643E The High Value must be numeric.

Explanation:  The High Value is not numeric. This is a required field to apply a 
dynamic logical view.

System action:  The error is highlighted and the field is marked. The user cannot 
apply a dynamic logical view until this field is corrected.

User response:  Enter a correct number.

BMCWAS2644E Low Value can not be greater than High Value.

Explanation:  The Low Value is greater than the High Value.

System action:  The error is highlighted and the field is marked. The user cannot 
apply a dynamic logical view until this field is corrected.

User response:  Enter correct values.

BMCWAS2645E You must insert a Low Value.

Explanation:  The Low Value field is required to apply a dynamic logical view.

System action:  The error is highlighted and the field is marked. The user cannot 
apply a dynamic logical view until this field is corrected.

User response:  Enter a Low Value.

BMCWAS2646E You must insert a High Value.

Explanation:  The High Value field is required to apply a dynamic logical view.

System action:  The error is highlighted and the field is marked. The user cannot 
apply a dynamic logical view until this field is corrected.

User response:  Enter a High Value.

BMCWAS2647E You must choose a column name.

Explanation:  The Column name is a required field to apply a dynamic logical 
view, if the previous line contains a condition.

System action:  The error is highlighted and the field is marked. The user cannot 
apply a dynamic logical view until this field is corrected.

User response:  Choose a column name.

BMCWAS2648E Number of Index Names must be equal to the number of Index Values.

Explanation:  The number of Index Names must equal the number of Index 
Values. This is a required condition to perform filtering.

System action:  The error is highlighted and the field is marked. The user cannot 
apply a filter until this field is corrected.
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User response:  Enter a correct Index Name and Index Value.

BMCWAS2649E Local Operations object cannot be created.

Explanation:  The Save operation failed.

System action:  The error is highlighted.

User response:  Clear the browser cache and try again.

BMCWAS2650E Operation is not valid.

Explanation:  The Operation is a required field to apply a dynamic logical view.

System action:  The error is highlighted and the field is marked. The user cannot 
apply a dynamic logical view until this field is corrected.

User response:  Choose an operator.

BMCWAS2651E Applet Error.

Explanation:  An applet error was received while displaying the Dynamic menu.

System action:  The error is highlighted. The Dynamic menu is not displayed.

User response:  Ensure that the wajar.jar file exists in the ../java folder where CGI 
is installed. Restart your browser and try again.

BMCWAS2652E Index unavailable. Click OK to retrieve the report without indexes. Click Cancel to 
return to the Index dialog box.

Explanation:  The user is trying to retrieve a report with an attached index, but 
the Server Interface cannot access the index.

The server is down or the report is corrupt.

System action:  According to the user response to the error message.

User response:  Select Yes to retrieve the report without indexes or select Cancel 
to return to the Index dialog box.

BMCWAS2653E Copies must be a number between 1 and 999.

Explanation:  An invalid character has been entered in the Copies field. 

System action:  The report is not printed.

User response:  Enter a numerical value for the number of copies that you want to 
print.

BMCWAS2654E Clear the page field to add the note to the current page, or click the Go button to 
get to the page shown in the page field.

Explanation:  The page field contains a number the doesn't match the currently 
viewed page.
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System action:  The page field is highlighted, and the tag note is not added.

User response:  Clear the page field to add the note to the current page, or click 
the Go button to get to the page shown in the page field.

BMCWAS2655E The value must be numeric, not less than 0, and not greater than [number].

Explanation:  The entered value is not valid.

System action:  The update does not take place.

User response:  Enter a valid numeric string.

BMCWAS2656E A new Logical View name must be specified in order to rename a logical view.

Explanation:  A new name for the Logical View was not entered.

System action:  The name field is highlighted, and the Logical View is not 
renamed.

User response:  Enter a new name for the Logical View.

BMCWAS2657E  A new Folder name must be specified.

Explanation:  A new name for the Folder was not entered.

System action:  The name field is highlighted, and the Folder is not renamed.

User response:  Enter a new name for the Folder.

BMCWAS2658E A destination Folder ID must be specified.

Explanation:  A destination folder for the operation was not entered.

System action:  The folder field is highlighted, and the operation is not 
performed.

User response:  Enter a destination folder.

BMCWAS2659E A new Report name must be specified.

Explanation:  A new name for the Report was not entered.

System action:  The name field is highlighted, and the Report is not renamed.

User response:  Enter a new name for the Report.

BMCWAS2660E Can not find Folder.

Explanation:  The system cannot find the folder that was specified as destination.

System action:  The folder or report management operation is not performed.

User response:  Please fill a valid folder name in the destination folder field, or 
select a folder from the folders tree.



Message codes and text

156 CONTROL-D/WebAccess Server User Guide

BMCWAS2661E A filter name must be specified for the new filter.

Explanation:  A name for the new filter was not entered.

System action:  The name field is highlighted, and the filter is not saved.

User response:  Enter a name for the filter.

BMCWAS2662E No predefined filters exist.

Explanation:  There are no predefined saved filters, so no filter can be deleted.

System action:  The delete operation cannot be performed.

User response:  You need to have at least one predefined filter in the list in order 
to delete a filter.

BMCWAS2663E A Report Name can be 120 characters only and can not include /, \\, \", \'.

Explanation:  Invalid report name. A report name can be 120 characters only and 
can not include /, \\, \", \'.

System action:  The report name field is highlighted and report operation is not 
performed.

User response:  Enter a valid report name.

BMCWAS2664E A Folder Name can be 120 characters only and can not include /, \\, \", \'.

Explanation:  Invalid folder name. A folder name can be 120 characters only and 
can not include /, \\, \”, \'.

System action:  The folder name field is highlighted and folder operation is not 
performed.

User response:  Enter a valid folder name.

BMCWAS2665E A Logical View Name can be 8 characters only and can not include /, \\, \”, \'.

Explanation:  Invalid logical view name. A logical view name can be 8 characters 
only and can not include /, \\, \”, \'.

System action:  The logical view name field is highlighted and logical view 
operation is not performed.

User response:  Enter a valid logical view name.

BMCWAS2666E Please specify date.

Explanation:  Filtering cannot be done according to times only. You must also 
specify the date for the filter.

System action:  The date type field is highlighted, and the filter is not applied.

User response:  Fill the date fields, or clear the time fields in order to apply the 
filter.
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BMCWAS2667E Only text reports can be sent as email text.

Explanation:  A text report with transformation to a non-text format cannot be 
send as email text.

System action:  The transformers field is highlighted and the mail message with 
the report is not created.

User response:  Select a transformer to a text format (might also be the default 
transformer), or select another email option (URL or attachment).

BMCWAS2668E This is not a valid page range.

Explanation:  The specified page range value is invalid.

System action:  The pages field is highlighted and the operation is not performed.

User response:  Enter valid page ranges value. Page ranges should be separated 
by comma, and can specify one page (for example 3) or several pages (2-5). The 
page ranges must not exceed the number of the report pages.

BMCWAS2669E An index must be selected before opening this type of report.

Explanation:  You must select an index before opening this report.

System action:  The report is not opened or the report operation is not performed.

User response:  Select Open Index from the pop-up menu of the report, or fill an 
Index information in the Index tab.

BMCWAS2670E CONTROL-D/WebAccess Server Web pages contain functionality that may not be 
supported by your browser.
For full support, use Netscape 6.2 or 7.0 or Internet Explorer 5.5 SP2 or 6.0.

Explanation:  Some functionality used by the CONTROL-D/WebAccess Server 
Web application is not supported on the current browser.

System action:  Some features of CONTROL-D/WebAccess Server Web 
application may not function correctly.

User response:  Use the CONTROL-D/WebAccess Server Web application with a 
supported browser.

BMCWAS2671E The search term must be one word only (no spaces or tabs).

Explanation:  When searching for text in an HTML report, only one word can be 
used for search.

System action:  The search is not performed.

User response:  Type only one word as a search phrase.

BMCWAS2672E Multiple Print support text and HTML reports only.

Explanation:  When using Multiple Print, only Text and/or HTML report can be 
used.
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System action:  The Multiple Print operation is not performed.

User response:  Select only text and HTML reports for Multiple Print.

BMCWAS2673E One or more of the selected reports must be opened with an index.
Multiple Print cannot be used for this report set.

Explanation:  At least one of the reports in the reports selected for Multiple Print 
must be opened with an index.

System action:  The Multiple Print operation is not performed.

User response:  Select only reports that can be opened without an index for the 
Multiple Print operation.

BMCWAS2674E Printing is limited to <p> pages.

Explanation:  Printing of reports is limited to <p> number of pages.

System action:  The report is not printed.

User response:  Select a smaller number of pages to be printed.

BMCWAS2675E Print Mission can be 8 characters only.

Explanation:  The Print Mission field cannot be longer then 8 characters.

System action:  The report is not sent to be printed on the host.

User response:  Fill a Print Mission field that is no longer then 8 characters.

BMCWAS2676E The filter definition space is full. Delete one or more previously saved filter 
definitions before saving the new one.

Explanation:  Pre-defined filters are saved in browser cookies, which are limited 
in space. This space is full, so the filter cannot be saved.

System action:  The pre-defined filter is not saved.

User response:  Delete some previously saved filters to free some space for the 
new filter to be saved.

BMCWAS2677E You cannot move or copy a folder to itself. Specify a different folder.

Explanation:  A folder cannot be copied or moved to itself.

System action:  he copy folder or move folder operation is not performed.

User response:  You can only copy or move the folder to another folder.

BMCWAS2678E The report cannot be put into the root folder.

Explanation:  The root folder cannot contain reports so a report cannot be copied 
or moved to the root folder.

System action:  The copy report or move report operation is not performed.
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User response:  You can only copy or move the report to folder which is not the 
root folder.

BMCWAS2679E The filter will be applied, but because the filter definition space is full, the filter 
cannot be saved as the “Last Used Filter”. You must delete one or more 
previously saved filter definitions to make room for the current definition.

Explanation:  Pre-defined filters are saved in browser cookies, which have 
limited memory. This memory is now full so, although the filter will be applied, 
it will not be saved as the last used filter for later usage.

System action:  The current filter is not saved as the last used filter.

User response:  Delete some previously saved filters to make some memory 
available for saving the current filter as the last used filter.

BMCWAS2680E The field [field name] can be [number] characters only.

Explanation:  The number of characters in the new value for the specified field is 
greater than the specified number.

System action:  The report field is not updated.

User response:  Enter a smaller value for the field.

BMCWAS2680Ea The field [field name] is too long.

Explanation:  The number of characters in the new value for the specified field is 
greater than the specified number.

System action:  The report field is not updated.

User response:  Enter a smaller value for the field.

BMCWAS2681E A Pagedef can be 6 characters only and can include only [a-z], [A-Z], [0-9].

Explanation:  Invalid Pagedef value was specified in the Host Print window. The 
Pagedef field must only be six characters long.

System action:  The report is not printed.

User response:  Correct the error in the Pagedef field and re-enter the 
information.

BMCWAS2682E A Formdef can be 6 characters only and can include only [a-z], [A-Z], [0-9].

Explanation:  Invalid Formdef value was specified in the Host Print window. 
The Formdef field must only be six characters long.

System action:  The report is not printed.

User response:  Correct the error in the Formdef field and re-enter the 
information.
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BMCWAS2683E Error %1 occurred during XPI installation.

Explanation:  Installation for Netscape or Firefox failed.

System action:  Local operation is not installed.

User response:  Contact system administrator.

BMCWAS2684E Invalid Note Format. Maximum number of lines allowed is 10.

Explanation:  The number of lines in the note is greater than the allowed 
maximum.

System action:  The note is not added.

User response:  Reduce the number of lines.

BMCWAS2685E Mailing is limited to <p> pages.

Explanation:  The number of pages in the email is greater than the allowed 
maximum.

System action:  The email is not sent.

User response:  Reduce the number of pages.

BMCWAS2686E Only text reports can be used in Multiple Find.

Explanation:  User selected one or more non-text reports to be searched.

System action:  The selected reports are not searched.

User response:  Deselect all non-text reports and apply the Multiple Find only to 
text reports.

BMCWAS2687E Please enter a string to search.

Explanation:  A search string was not entered.

System action:  The search is not performed.

User response:  Enter a string in the search field.

BMCWAS2688E None of the selected reports could be opened. The unified report could not be 
created.

Explanation:  None of the PDF reports can be opened.

System action:  The unified report cannot be created.

User response:  Contact system administrator.
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BMCWAS2689E Your CONTROL-D/WebAccess Server installation and Internet Access Method are 
not configured to use the same character encoding.

Please contact your administrator.

Explanation:  The CONTROL-D/WebAccess Server and the Internet Access 
Method are configured with different character encodings.

System action:  User cannot access CONTROL-D/WebAccess Server.

User response:  Contact system administrator.

BMCWAS2690E Some of the selected reports could not be opened. Do you want to create a unified 
report that contains the remaining reports?

Explanation:  One or more of the PDF reports cannot be opened.

System action:  If user enters Yes, the unified report will be created, but without 
the reports that could not be opened. If user enters No, the unified report will 
not be created.

User response:  Enter either Yes or No.

BMCWAS2691E Report #%1 (%2) returned an error: %3

Explanation:  Error when opening the report.

System action:  The report will not be added to unified report.

User response:  Contact system administrator.
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Index

A
accessing report page sets 45
accessing repository reports 21
adding

blank columns 102
blank lines 102
filled rows and columns 119
text 121

adjusting overlay size 126
advanced find 47
areas 107

B
Backup display type 137
BMC Software, contacting 2

C
Category display type 137
change language hyperlink 22
change password hyperlink 22, 23, 25
Change Password window, opening 25
changing fonts 114
changing your repository password 25
Chars display type 137
Checked Out By display type 137
checking in a report 71
checking out a report 70
Check-Out Status display type 137
choosing the user interface language 26
Class display type 137
coloring report areas 107
conventions 15
cookies 26
Copies display type 137
copying

folders 66
reports 68
text 102

creating
folders 66
general notes 73
reports 67
tag notes 74

creating a general note 73
creating a tag note 74
creating general notes 73
creating tag notes 74
current date 37
current date format is 37
current date is 37
customer support 3
customizing the report display 53

D
date

current 37
format 37
from/to 36
period 36
type 35

date from/to 36
date type 35
dates, filtering by 35
Decollation Date display type 137
Decollation Time display type 137
deleting

filter definitions 31
folders 67
reports 68, 69

deleting tag icons 78
deleting tag notes 78
deselecting report areas 97
Dest display type 137
display types 137
displaying folders 28
displaying reports 27
downloading a locked report 72
dynamic logical views

applying 57
creating 123

E
Email display type 138
Email window, opening 79
emailing reports 79
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Enable Text Search display type 138
Encoding display type 138
error messages 141
ewing 76
excluding lines 111
Expiration Date display type 138
exporting a report to an excel file 128

F
File Ext. display type 138
filling down text 117
filling text 119
filter check box 22
filter options and buttons 32
filter tabs 32
Filter window

Date & Time tab 35
Index tab 38
opening 30
options and buttons 32
Report Parameters tab 32
Report Type tab 38

filtering
before displaying the Report List window 22
by index values 38
by report characteristics 32
by specified report types 38
clearing filter criteria 32
deleting filter definitions 31
for matching text 34
purpose 30
reducing access time 22
saving filter definitions 31
using wildcards 34

filtering the report list 30
filtering with wildcard characters 34
Final display type 138
finding text

overview 46
using the Advanced Find window 47
using the Find text box 46

finding the reports you need 27
folder management

copying 66
creating 66
deleting 67
moving 66
renaming 66

folder path navigation 28
folders

browsing 28
CONTROL-D/PC archives 28
displaying 28
managing 65
viewing contents 29

Form display type 138
formatting fields 135
freezing margins 105, 116
freezing report areas 56
French. See user interface language
From User display type 138

G
Generation display type 138
German. See user interface language
getting started 21

H
Hebrew-enabled. See user interface language
help button 22
hiding report areas 104
host name 22
host print 83
how this book is organized 13

I
identifying data preferences 94
including lines 111
indexes

searching for reports by 52
using to view a report 52

Is Last Version display type 138
Italian. See user interface language

J
Job End Date display type 138
Job End Time display type 138
Job ID display type 138
Job Name display type 138
Job Start Date display type 138
Job Start Time display type 138

L
Language display type 138
language of the user interface, changing 26
Lines display type 138
Location display type 138
logging on 21

changing the user interface language 22
changing your repository password 22, 23
filter check box 22
host name 22
login button 22
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password 22, 23
user name 22, 23

Logical view
accessing report pages 96

logical views
applying 54

clearing mask criteria 58
dynamic logical views 57
freezing headers, footers, and edges 56
viewing reports in spreadsheet format 55

creating
adding blank columns 102
adding blank lines 102
adding filled rows and columns (filling text) 119
adding text 121
adjusting overlay size 126
adjusting the size of the overlay 126
applying dynamic definition labels 123
applying font changes 114
applying overlays 124
assigning spreadsheet cell types 132
basics 90
changing fonts 114
coloring areas 107
coloring report areas 107
copying text 102
defining coloring conditions 110
defining colors 109
definition labels 123
deselecting report areas 97
exporting a report to an excel file 128
filling down text in existing columns 117
formatting fields 135
freezing margins 105, 116
hiding repetitive text 116
hiding report areas 104
identifying data preferences 94
manipulating instructions 98
manipulating text 116
masking areas (including and excluding lines) 

111
masking operators 113
moving and copying text 102
moving text 102
navigating the report 96
selecting and deselecting report areas 97
selecting text when an overlay is inserted 126
working with multiple overlays 127

data preferences
defining 94
number format 95
search options 95
user-defined sign 95

Logical View Editor buttons 92
managing 89

deleting 101
renaming 101

saving 100
overview 53

login button 22
login window

Predefined Hosts 23
Selected Hosts 22

M
managing

folders and reports 65
logical views 89

managing folders and reports 65
manipulating instructions 98
manipulating text 116
marking reports tag icons 76
masking areas 111
masking operators 113
message codes and text 142
moving

folders 66
reports 68, 69
text 102

multiple overlays 127
Multiple Report Print window, opening 83
multiple values 35

N
navigating report pages 45
navigating the Report List window 28
navigating the report list window 28
Notes mode 74, 75, 76, 77

O
online books 14
online Help 14, 22
online help 14
Order Date display type 138
Original Encoding display type 139
overlays

adjusting size 126
applying 124

overview 17

P
Page List Mode display type 139
Pages display type 139
password

changing 25
logging on 22, 23

period 36
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Portuguese. See user interface language
Predefined Hosts Login window 23
predefined hosts login window 23
prepare to print 84
print 81
Print display type 139
printing

multiple reports 83
to a local printer 81
to a mainframe printer 83
to browser printer 84

printing notes 77
printing reports 81
product support 3
Properties display type 139

R
Recfm display type 139
Recipient display type 139
related documentation 14
release notes 14
Remark display type 139
renaming

folders 66
logical views 101
reports 68, 69

renaming, copying, moving, and deleting reports 68
report icons 27
Report Icons display type 139
report indexes 52
Report List window

navigating 28
Report List window, navigating 28
report list, sorting 40
report management

copying 69
creating 67
deleting 69
moving 69
renaming 69

Report Name display type 139
report notes

opening the Report Notes window 73
Report Notes window, opening 73
Report Operations 67
report page sets, accessing 45, 96
report properties

updating 86
viewing 86

report versions
checkin 71
checkout 70
downloading 72
reverting 71

Report Viewing window, modes 43

reports
copying 68
deleting 68
displaying 27
finding 27
managing 65
moving 68
printing 81
renaming 68
saving 85
selecting for viewing 28
transforming a text report with an export definition 62
viewing

in native format 63
in transformed format 60
text reports as-is 61
text reports in Excel format 61

reports, sending as email 79
repository access 21
repository password, changing 25
Resource Set ID display type 139
reverting to a previous report version 71

S
Save display type 139
saving

filter definitions 31
logical views 100
reports 85

saving reports 85
searching for text

overview 46
using the Advanced Find window 47
using the Find text box 46

searching for text strings 46
Selected Hosts Login window 22
selected hosts login window 22
selecting report areas 97
selecting reports for viewing 28
Sort window, opening 40
sorting the report list 40
Spanish. See user interface language
starting CONTROL-D/WebAccess Server 21
Status display type 139
support, customer 3

T
technical support 3
Text Search Ready display type 139
text, finding 47
time

filtering by 35
from/to 37
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time from/to 37
Transfer Date display type 139
Transfer Time display type 139
tree navigation 28
Type display type 139

U
updating report properties 86
URL (Universal Resource Locator)

emailing reports as 79
starting CONTROL-D/WebAccess Server 21

User Dest display type 140
user interface language, changing 26
user name 22, 23
using dynamic logical views 57
using find 46
using indexes to view reports 51
using report notes 72
using static logical views 54

V
Version display type 140
View mode 74, 75, 76, 77
viewing

folder contents 29
notes 76
report properties 86

viewing notes 76
viewing report properties 86
viewing reports 43

in native format 63
in transformed format 60

viewing reports in native format 63
viewing reports in transformed format 60
viewing reports in transformed formats 60
viewing text reports in excel format 61

W
wildcard characters 34
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